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はじめに 

Cisco TelePresence Management Suite Extension for Microsoft Exchange（Cisco TMSXE）は Cisco TelePresence 

Management Suite の拡張機能です。これにより、Microsoft Outlook を使用してビデオ会議をスケジューリングしたり、Cisco 

TMS の会議の情報を Outlook の会議室の予定表に複製したりできます。 

この導入ガイドでは、新しい導入の準備、セットアップ、および設定方法について説明します。また、Cisco TMSXE の以前のバ

ージョンからのアップグレード、および導入操作や一般的な操作の最中に発生する問題のトラブルシューティングについても説

明します。 

関連資料 

次の表に、このドキュメントで参照されているドキュメントと Web サイト、および関連するマニュアルを示します。Cisco 

TelePresence Management Suite Extension for Microsoft Exchange の最新バージョンのすべてのマニュアルについては、

www.cisco.com/en/US/products/ps11472/tsd_products_support_series_home.html を参照してください。 

タイトル リンク 
Cisco TelePresence Management Suite Extension for Microsoft Exchange Software Release Notes (5.0) cisco.com 
Cisco TelePresence Management Suite Extension for Microsoft Exchange User Guide (5.0) cisco.com 
Cisco TelePresence Management Suite Booking API Programming Reference Guide cisco.com 
 

トレーニング 

トレーニングはオンラインおよびシスコ指定のトレーニング会場で受講できます。シスコが提供するすべてのトレーニングの詳

細およびトレーニング オフィスの場所については、www.cisco.com/go/telepresencetraining [英語] を参照してください。 

用語集 

TelePresence 関連の用語集は tp-tools-web01.cisco.com/start/glossary/ [英語] で入手できます。 

前提条件 
ここでは、Cisco TMSXE 5.0 をインストールするための前提条件とベスト プラクティスについて詳しく説明します。これらの

情報は、新規インストールとアップグレードの両方に適用されます。 

http://www.cisco.com/en/US/products/ps11472/tsd_products_support_series_home.html�
http://www.cisco.com/en/US/products/ps11472/prod_release_notes_list.html�
http://www.cisco.com/en/US/products/ps11472/products_user_guide_list.html�
http://www.cisco.com/en/US/products/ps11472/products_programming_reference_guides_list.html�
http://www.cisco.com/go/telepresencetraining�
https://tp-tools-web01.cisco.com/start/glossary/�
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導入サイズの見積り 

Cisco TMS の要件は導入環境の規模や複雑さに応じて増加します。インストールの複雑さは、主にアクティビティの量と、

Cisco TMS によって制御される予約可能なエンドポイントの数によって決まります。 

次の表を使用して導入環境の相対的なサイズを特定します。複数の条件と一致する場合は、最も高いレベルを適用します。 

 通常および Cisco BE6000 環境 大規模環境 

Cisco 
TMS 

• 制御対象システム数：200 未満 

• 同時参加者数：100 未満 

• 同時進行するスケジュール済み

会議数：50 未満 

• システム ライセンスを使用するシステム（制御対象システム、

Cisco TMS に追加された Unified CM に登録されるシステム、お

よび管理対象外のルーム）数：5,000 未満。このようなシステム

を 5,000 個を超えて追加することはサポートされていません。 

• 同時参加者数：1800 未満 

• 同時進行するスケジュール済み会議数：250 未満 

Cisco 
TMSXE 

Microsoft Exchange で予約可能なエ

ンドポイント数：50 未満 

オンプレミスの Microsoft Exchange で予約可能なエンドポイント数：

1,800 未満 

または 

Office 365（またはオンプレミスの Exchange と Office 365 の組み合

わせ）で予約可能なエンドポイント数：1,000 未満 

Office 365 では、Exchange に対する遅延がオンプレミス導入に比べて

一般に大きくなることに注意してください。その結果、Cisco TMSXE 

で、関連するイベントがすべて処理される前に予約が保存される場合が

あります。この場合、同じ予約に対して複数の電子メール通知がユーザ

に送信されます。 

Cisco 
TMSPE 

• Collaboration Meeting Room 
数：1,000 未満 

• Cisco VCS でプロビジョニング

されるユーザ数：2,000 未満

（注：Cisco VCS のプロビジョ

ニングは BE6000 ではサポート

されていません） 

• Collaboration Meeting Room 数：48,000 未満 

• Cisco VCS でプロビジョニングされるユーザ数：100,000 未満 

共存 3 つのアプリケーションと Microsoft 

SQL Server はすべて共存可能。 

• Cisco TMSXE に専用サーバが必要。 

• Cisco TMS と Cisco TMSPE は外部 SQLServer を使用する必要

がある。 
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Cisco TMS のパフォーマンスや規模に影響するその他の要因には次のものがあります。 

• Cisco TMS の Web インターフェイスにアクセスするユーザの数。 

• スケジュールまたは監視されている会議の同時開催。 

• アドホック会議モニタリングの使用。 

• 複数の拡張またはカスタム クライアントによる Cisco TMSBA の同時使用。予約のスループットは、Cisco TMS の 

[New Conference] ページを含むすべてのスケジューリング インターフェイスで共有されます。 

実際の予約スピードは、会議のサイズ、機能、および会議のスケジュールの複雑さによって異なります。 

ハードウェア要件 

導入環境のサイズに応じて該当するハードウェア要件を以下で確認してください。 

SQL Server を含むすべてのアプリケーションは、以下のハードウェア要件に対応する仕様の仮想マシンにもインストールできます。 

通常の導入と Cisco Business Edition 6000 

通常の導入環境では、Cisco TMS と拡張を同じサーバに配置できます。 

 要件 Cisco BE6000 

CPU 2 コア（Xeon 2.4 Ghz 以上）、専用 1 vCPU  

メモリ 8 GB、専用 4 GB の vRAM、専用  

サーバで提供されるディスク容量 60 GB 60 GB 

 

Cisco Business Edition 6000 上の Cisco TMSPE には、エンドポイントまたは FindMe 向けの Cisco VCS ベースのユーザ プロ

ビジョニングが含まれないことに注意してください。 

大規模な導入 

大規模な導入環境では、Cisco TMSXE と SQL Server を外部に配置する必要がありますが、Cisco TMS と Cisco TMSPE は常

に共存させることができます。 

Cisco TMS および Cisco TMSPE サーバ 

 要件 

CPU 2 コア（Xeon 2.4 Ghz 以上）、専用 

メモリ 8 GB、専用 

サーバで提供されるディスク容量 80 GB 

 



Cisco TelePresence Management Suite Extension for Microsoft Exchange 導入ガイド 

 

はじめに 

5 

Microsoft SQL Server 

このサーバは、Cisco TMS サーバと同じタイム ゾーンに属している必要があります。 

 要件 

CPU 4 コア（Xeon 2.4 Ghz 以上）、専用 

メモリ 16 GB、専用 

サーバで提供されるディスク容量 60 GB 

 

大規模な導入を計画している場合は、次の点にも注意してください。 

• 大規模 tmsng データベースに必要なディスク領域は、通常 20 ～ 30 GB です。 

• ほとんどの導入では、3 つの Cisco TMSPE データベースのサイズが 6 GB を超えることはありません。 

• SQL Server のパフォーマンスに影響する主な要因は RAM とディスク I/O です。最適なパフォーマンスを得るためには、

これらの値をできるだけ増やす必要があります。 

Cisco TMSXE サーバ 

このサーバの要件は、サポートされているオペレーティング システムの推奨ハードウェア要件と同じです。 

推奨される Cisco TMS の設定変更 

大規模な導入では、SQL Server と Cisco TMS サービスの負荷を軽減するために、次の設定を強く推奨します。 

• [Administrative Tools] > [Configuration] > [Conference Settings]：[Default R eservation Type for Scheduled Calls] 

を [One Button To Push] に設定します。 

• [Administrative Tools] > [Configuration] > [General Settings]：[Route Phone Book Entries] を [No] に設定します。 

• [Administrative Tools] > [Configuration] > [Network Settings]：[Enable Ad Hoc Conference Discovery] を [Only for 

MCUs] または [No] に設定します。 

Cisco TMSXE サーバのソフトウェア要件 

ソフトウェア要件は導入環境のサイズとは無関係です。環境のサイズに適したハードウェア要件については、「導入サイズの見

積り」（3 ページ）および「ハードウェア要件」（4 ページ）を参照してください。 
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ソフトウェア 

表 1 Cisco TMSXE サーバのソフトウェア要件 

製品 バージョン 

Microsoft Windows Server • 2012（ビルド 9600 まで） 

• 2008 Service Pack 2（64 ビット） 

• 2008 R2 Service Pack 1 

Microsoft .NET Framework • .NET Framework Full（拡張）が必要 

• バージョン 4.0 以降。 

 

Active Directory および DNS 

Active Directory システムの要件は、Exchange での要件と同じです。 

Cisco TMSXE サーバは、次の条件を満たす必要があります。 

• Exchange サーバの Active Directory ドメイン用のサービス レコードを持つ DNS サーバを使用するように設定されてい

ること。 

• Active Directory にネットワーク経由でアクセスできること（つまり、トラフィックをブロックするファイアウォールが

存在せず、LDAP とグローバル カタログが開かれていること）。この通信は、Cisco TMSXE Exchange サービス ユーザ 

アカウントを使用して認証されます。アカウントの設定手順については、「Active Directory での Cisco TMSXE サービ

ス ユーザの作成」（23 ページ）を参照してください。 

Active Directory アカウントの表示名を更新するには、Cisco TMSXE Windows サービスを再起動して新しい名前を適用する必

要があります。 

Cisco TMS Booking Service の要件 

TelePresence および WebEx Productivity Tools を使用するには、Cisco TMSXE のインストール時に Cisco TMS Booking 

Service を含める必要があります。Booking Service は、Windows Server の Web サーバである IIS を使用します。 

Booking Service を動作させるには、Cisco TMSXE と Booking Service の両方がインストールされているサーバ上の IIS で、既

定の Web サイトの HTTPS を有効にする必要があります。冗長導入では、両方のノードでこれを行う必要があります。 

事前に IIS がインストールされていないサーバでは、Booking Service と一緒に自動的にインストールされます。インストール後、

既定の Web サイトに HTTPS を設定する必要があります。 

詳細については、「IIS の HTTPS 設定」（51 ページ）を参照してください。 
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Cisco TMS の要件 

表2 Cisco TMS サーバの要件 

バージョン 14.5 

ネットワーク Cisco TMSXE サーバから Cisco TMS への接続には HTTPS（推奨）または HTTP が必要です。 

 

ライセンス要件 

Cisco TMSXE で予約される各 TelePresence エンドポイントは、事前に Cisco TMS に追加されており、一般的な Cisco TMS 

の使用についてライセンスを受けている必要があります。 

さらに、Cisco TMSXE をこれらのエンドポイントの予約に使用するためには、次のいずれかが必要です。 

• Cisco TMS と統合されている 25 の TelePresence エンドポイントごとに 1 つの Cisco TMSXE（Extension for 

Microsoft Exchange）オプション キー。通常は小規模な導入環境で推奨されます。システム ライセンスを有効にする方

法の詳細については、下記を参照してください。 

• Cisco TMSXE のインストールごとに 1 つのアプリケーション統合パッケージ オプション キー。このオプションは、多

数のエンドポイントがある導入環境で推奨されます。 

両方のライセンス キーがある場合、アプリケーション統合パッケージ オプション キーのみが Cisco TMS で使用されます。 

オプション キーの有効化 

Cisco TMS のオプション キーを有効にするには、次の手順を実行します。 

1. [Administrative Tools] > [Configuration] > [General Settings] に移動します。 

2. [Licenses and Option Keys] ペインで、[Add Option Key] をクリックします。 

3. オプション キー文字列を入力します。 

4. [Save] をクリックします。 

システム単位のライセンス 

Cisco TMS でシステム単位のオプション キーを有効にした場合、各システムのライセンス使用は [Allow Remote Bookings] の

設定で決定されます。 

アプリケーション統合パッケージ オプション キーを使用する場合、この設定は無効であり、非表示になります。両方のオプショ

ン キーを追加した場合は、アプリケーション統合パッケージ オプション キーのみが Cisco TMS で使用されます。 
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Cisco TelePresence Management Suite Extension Booking API を使用した初回予約時に、Cisco TMS でそのシステムの 

[Allow Remote Bookings] が [Yes] に切り替わります（ライセンスが使用可能な場合）。使用可能なライセンスがない場合、そ

のシステムの [Allow Remote Bookings] は [No] のままになり、要求された予約は拒否されます。この場合、使用可能なライセ

ンスがないことを管理者に通知する Cisco TMS チケットが生成されます。 

構成ツールでエンドポイントを追加するたびに Cisco TMSXE によりテスト予約が実行され、[Allow Remote Bookings] が有効

になることに注意してください。 

この設定を表示および変更するには、次の手順を実行します。 

1. Cisco TMS で、[Systems] > [Navigator] に移動します。 

2. 目的のシステムを選択します。 

3. [Settings] タブをクリックします。 

4. [TMS Scheduling Settings] ペインに、[Allow Remote Bookings] があります。 

設定が [Yes] の場合、システムは現在 Exchange 統合オプション ライセンスを使用しています。 

5. この設定を無効にするには、次の手順を実行します。 

1. [Edit Settings] をクリックします。 

2. [Allow Remote Bookings] をオフにします。 

3. [Save] をクリックします。 

Cisco Collaboration Meeting Rooms Hybrid の要件 

WebEx の会議で Cisco TMSXE を使用するには、次の要素を使用して Cisco TMS をセットアップする必要があります。 

• 1 つ以上の WebEx サイト 

• 各ユーザ（サービス ユーザではない）の WebEx クレデンシャル（手動で追加するか、WebEx/Cisco TMS のシングル 

サイン オンを使用） 

シングル サインオンを使用する（または使用しない）場合の Cisco Collaboration Meeting Rooms Hybrid の設定手順について

は、『Cisco Collaboration Meeting Rooms Hybrid Configuration Guide』を参照してください。 

Microsoft Exchange の要件 

表 3 Microsoft Exchange Server の要件 

要件 説明 

Microsoft Exchange テスト済みのバージョン： 

• Microsoft Exchange 2013 および 2013 Service Pack 1 

• Microsoft Office 365 for Enterprise（Exchange Online）バージョン 15.0.898.9 またはそれ

未満新しいバージョンについては、入手可能になり次第、テストします。 

http://www.cisco.com/c/en/us/support/conferencing/telepresence-management-suite-tms/products-installation-and-configuration-guides-list.html�
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要件 説明 

組織で使用されている Office 365 のバージョンを確認するには、Microsoft の次の手順に従って

ください。 

Verify Office 365 tenant version and status 
• Microsoft Exchange 2010 Service Pack 3 
• Microsoft Exchange 2007 Service Pack 3 

Windows Server テスト済みのバージョン： 

• Microsoft Windows Server 2012 
• Microsoft Windows Server 2008 R2 
• Microsoft Windows Server 2008 

Exchange Web 
Services（EWS）  

Exchange サーバ上で有効にする必要があります。 

Active Directory オンプレミスで使用可能である必要があります。 

Office 365 を使用する場合は、Active Directory フェデレーション サービスと Windows Azure 

Active Directory 同期ツールが必要です。 

 

クライアント アクセス サーバの冗長性と自動検出 

Cisco TMSXE は、次の機能を使用して複数のクライアント アクセス サーバ（CAS）をサポートします。 

• 自動検出（Exchange 環境と Cisco TMSXE 設定ツールの両方で有効にする必要があります） 

• ネットワーク ロード バランサ（NLB） 

• Exchange 2010 では、exchangeCookie を使用するか、または 1 つの CAS サーバに対してスティッキー IP 接続

（アフィニティ）を行うように NLB を設定する必要があります。 

• Exchange 2007 では、1 つの CAS サーバに対してスティッキー IP 接続（アフィニティ）を行うように NLB を

設定する必要があります。 

• CAS のフェールオーバー（2010 および 2007）またはメールボックスのフェールオーバー（2013）が発生した

場合は、再登録時にパフォーマンスが低下することがあります。サブスクリプションは CAS インスタンス

（2010 および 2007）またはメールボックス サーバ（2013）ごとに保存されるため、ネットワーク ロード バラ

ンサがプライマリ CAS に到達できない場合、Cisco TMSXE はほかの CAS にリダイレクトされ、リソース メー

ルボックスの再購読が実行されます。 

• 設定手順については、TechNet の記事「Load Balancing Requirements of Exchange Protocols」を参照してくだ

さい。 

http://technet.microsoft.com/en-us/library/hh534377(v=exchg.150).aspx#verify�
http://technet.microsoft.com/en-us/library/ff625248.aspx�
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証明書認証 

必要に応じて、Exchange および Active Directory で Cisco TMSXE サービス ユーザを認証するときに、ユーザ名とパスワード

ではなくクライアント証明書とパスワードを使用できます。 

• クライアント証明書認証を使用するように Exchange CAS を設定する必要があります。手順については、Exchange の

マニュアルを参照してください。 

• Cisco TMSXE のファイル システムから到達できる有効な Personal Information Exchange（PKCX #12）（.pfx）クライ

アント証明書が必要です。 

クライアント要件 

Cisco TMSXE は、次のクライアントおよび Exchange バージョンを使用してテストされています。 

表 4 Exchange サーバとクライアントのバージョン 

クライアント Exchange のバージョン 

Office 365 Office 365 

Microsoft Outlook 2013  Office 365 と Exchange 2013 

Office 365 と Outlook 2013 では Productivity Tools がサポートされないことに注意してく

ださい。 

Outlook Web App Exchange 2010 および 2013 

Microsoft Outlook 2010 Exchange 2010 

Microsoft Outlook 2007 SP2 Exchange 2007 

 

詳細設定は Cisco TelePresence フォームで使用可能ですが、このフォームは Windows 用のローカル Outlook クライアントで

のみ使用できます。 

Cisco TMSXE 5.0 をインストールする前に、ユーザが会議室メールボックスを使用する会議を予約できるように Outlook と 

Exchange の両方が設定済みであることを確認してください。 

導入シナリオとベスト プラクティス 

ここでは、Cisco TMSXE でサポートされる導入シナリオと、各シナリオで注目すべき機能、制限事項、およびベスト プラク

ティスについて説明します。 
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Cisco Collaboration Meeting Rooms Hybrid 導入 

Cisco Collaboration Meeting Rooms Hybrid を Cisco TMSXE およびサポート対象バージョンの Exchange と組み合わせて使用

することにより、ユーザは自分のメール クライアントから直接 WebEx コンポーネントを使用して TelePresence 会議を予約で

きるようになります。 

Cisco TMSXE を使用して Cisco Collaboration Meeting Rooms Hybrid 会議を予約するには、WebEx Scheduling Mailbox と 

WebEx Productivity Tools with TelePresence の 2 つの方法があります。 

• 要件については、「Cisco Collaboration Meeting Rooms Hybrid の要件」（8 ページ）を参照してください。 

• Cisco Collaboration Meeting Rooms Hybrid ソリューション全体の概要については、『Cisco Collaboration Meeting 

Rooms Hybrid Configuration Guide』を参照してください。 

WebEx Scheduling Mailbox 

WebEx Scheduling Mailbox を使用して、会議の招待状に特別な電子メール アドレスを追加することにより、任意のバージョン

の Exchange で Cisco Collaboration Meeting Rooms Hybrid 会議をスケジュールできます。 

設定手順については、「WebEx Scheduling Mailbox の設定」（47 ページ）を参照してください。 

TelePresence を使用した WebEx Productivity Tools 

Productivity Tools を使用すると、ユーザが Outlook から WebEx を使用して TelePresence を予約したり、両方のコンポーネン

トの詳細設定を変更したりできるようになります。 

Cisco TMSXE とともに Productivity Tools を使用するには、Cisco TMS Booking Service をインストールして設定する必要があ

ります。 

設定手順については、「Cisco TMSXE を使用した WebEx Productivity Tools with TelePresence の設定」（50 ページ）を参照

してください。 

Cisco TMSXE ではルーム メールボックスの代理がサポートされますが、Outlook で Productivity Tools を使用する場合はサポー

トされません。 

Productivity Tools の制限事項と Exchange および Outlook のバージョンについては、お使いのバージョンの WebEx Meeting 

Center のマニュアルを参照してください。 

オンプレミス Exchange 導入 

Cisco TMSXE の全体をオンプレミスの Exchange サーバに導入できます。バージョン要件については、「Microsoft Exchange 

の要件」（8 ページ）を参照してください。 

Office 365 とオンプレミスの Exchange が混在する環境については、「ハイブリッド導入」（12 ページ）を参照してください。 

http://www.cisco.com/en/US/products/ps11338/products_installation_and_configuration_guides_list.html�
http://www.cisco.com/en/US/products/ps11338/products_installation_and_configuration_guides_list.html�
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Exchange 2007 での制限事項 

Cisco TMSXE の Exchange 2007 導入では、次の新機能が使用できません（またはサポートされません）。 

• Cisco TMSXE サービスのクラスタリング 

• Client Access サーバの自動検出（CAS Autodiscover） 

• リソース メールボックスの偽装 

• CAS とメールボックス サーバのいずれかまたは両方をクラウドに配置するハイブリッド導入 

Exchange 2007 のサポートは、今後のリリースで廃止される予定です。 

混在した Exchange 環境 

CAS の自動検出が有効であり、すべての CAS サーバで Exchange 2013 または 2010 が実行されている場合は、Exchange 

サーバを同じ導入で異なるサポート対象バージョンの Exchange と組み合わせることができます。 

Microsoft Office 365 導入 

Cisco TMSXE は、クラウドに CAS とメールボックス サーバを配置する Office 365 ベースの導入をサポートします。どの導入

でも、Cisco TMS を使用するには Active Directory をオンプレミスで配置し、Cisco TMSXE が Cisco TMS と同じ Active 

Directory にアクセスする必要があります。 

Microsoft は、Microsoft Office 365 の自動検出を有効にすることを推奨しています。 

制限事項 

• スモール ビジネス用の Office 365 プランは、これらのサブスクリプション モデルで使用可能な機能が制限されるため、

Cisco TMSXE ではサポートされません。 

• TelePresence の詳細設定と WebEx Productivity Tools with TelePresence にアクセスするには、ローカル Outlook クラ

イアントが必要です。 

Web メールにのみアクセスできるユーザは、WebEx Scheduling Mailbox を使用して Cisco Collaboration Meeting 

Rooms Hybrid 会議を予約できます。 

ハイブリッド導入 

Office 365 をオンプレミスの Exchange サーバと組み合わせて導入できます。Cisco TMSXE は、次の条件を満たした場合に、

オンプレミスとクラウドの Exchange サーバの組み合わせをサポートします。 

• オンプレミスの Exchange サーバが Exchange 2013（推奨）または Exchange 2010 であること。 

• Active Directory がオンプレミスであること（Cisco TMS を使用するために必要）。Cisco TMSXE は Cisco TMS と同じ 

Active Directory にアクセスする必要があります。 
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• すべてのユーザが各自の予約するルーム メールボックスおよび WebEx Scheduling Mailbox（該当する場合）と同じ環境

（オンプレミスまたは Office 365）に含まれていること。これは、ハイブリッド導入に対する Microsoft の制限事項によ

るものです。複数のプレミス間で同じサービス ユーザを使用できることに注意してください。Microsoft のこれらの制限

事項の詳細については、Microsoft のサポート記事「Cross-premises Calendar editing is unavailable in a hybrid 

deployment of Exchange Online in Office 365 and on-premises Exchange Server」を参照してください。 

複数のプレミスにまたがる予約に関する上記の制限事項は、Exchange がオンプレミスからクラウドまたはクラウドからオンプ

レミスに移行される環境にも適用されることに注意してください。 

すべてのメールボックスにルームが表示されるようにする 

複数のプレミスにまたがって予定表が表示されるようにするには、次の手順を実行します。 

• オンプレミス サーバで、サービス ユーザ、WebEx Scheduling Mailbox、およびすべてのルーム メールボックスを作成

します。 

• Microsoft の標準の手順またはツールを使用して、これらのメールボックスをクラウドに移動します。 

冗長導入 

Exchange 2010 以降では、次に示すクラスタリングとロード バランシングがサポートされます。 

Cisco TMSXE サービスのクラスタリング 

Cisco TMSXE サービスのアクティブ/パッシブ冗長性がクラスタリングによってサポートされます。Cisco TMSXE を最初のノー

ドにインストールするときに、クラスタリングのサポートを有効にする必要があります。 

各ノードは、設定フォルダとデータ フォルダを共有しますが、別個の場所にログを書き込みます。現在アクティブなノードと

パッシブなノードが、情報レベルでログに書き込まれます。トラブルシューティングの状況では、両方のログが必要になるこ

とに注意してください。 

一方のノードがダウンすると、もう一方が自動的にアクティブになります。アクティブ ノードのサービスを停止するか、または

サーバをリブートすると、フェールオーバーが強制的に発生します。 

前提条件と設定手順については、「サービスのクラスタリングを使用する Cisco TMSXE のインストール」（41 ページ）を参照

してください。 

Cisco TMS Booking Service の冗長性 

Cisco TMS Booking Service の冗長性は、ネットワーク ロード バランサ（NLB）を使用してサポートされます。この冗長設定

によって高可用性が確保されますが、パフォーマンスは向上しません。 

前提条件と設定の手順については、「Cisco TMS Booking Service の冗長性の設定」（46 ページ）を参照してください。 

http://support.microsoft.com/kb/2807149�
http://support.microsoft.com/kb/2807149�
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サポートされる冗長モデル 

Cisco TMSXE に冗長性を設定すると、『Cisco TelePresence Management Suite Installation and Upgrade Guide』の

「Redundant deployments」の章で説明されているとおり、Cisco TMS のロード バランシング設定との組み合わせにより、次

のシナリオがサポートされます。 

• Productivity Tools を使用しない場合は、「サービスのクラスタリングを使用する Cisco TMSXE のインストール」

（41 ページ）の説明に従って、Booking Service なしでインストールを行い、Cisco TMSXE サービス用に 2 つのクラス

タ ノードを設定します。 

• Productivity Tools を使用する場合： 

• 「サービスのクラスタリングを使用する Cisco TMSXE のインストール」（41 ページ）の説明に従って、Cisco 

TMSXE サービス用に 2 つのクラスタ ノードを設定します。 

• 「Cisco TMS Booking Service の冗長性の設定」（46 ページ）の説明に従って、両方のノードに Booking 

Service をインストールし、Booking Service ノード用のネットワーク ロード バランサを設定します。 

「大規模な導入に関するガイド」（14 ページ）で説明されているように、Cisco TMS と Cisco TMSXE が同じサーバにホスト

される小規模な導入では、冗長性はサポートされません。 

大規模な導入の手引き 

Cisco TMSXE は、多数のメールボックスが追加される導入のサポートを向上させるために基本設定を自動的に変更します。 

大規模な導入では、次の点に注意してください。 

• 構成ツール システム リストの入力、すべてのシステムの検証、追加されたメールボックスからの既存の会議のインポー

トに相当な時間を要する場合があります。 

• リンクされたシステムの数が増えるにつれて、Exchange メールボックスのチェック間隔が長くなります。つまり、1 つ

の会議のすべての参加者に関する情報を得る前に、Cisco TMSXE が Cisco TMS 予約を送信する場合があります。 

• この動作は、一般に、Cisco TMSXE に 1700 を超えるメールボックスが追加される導入で見られます。 

• これにより、複数の会議室が予約された場合、ユーザが同じ予約に対して複数の確認を受信する場合があります。 

• その結果、会議は意図したとおりに機能しますが、追加の通知および部分的な予約はユーザを混乱させる可能性が

あります。 

すべての導入のベスト プラクティス 

メールボックスのインストール、アップグレード、および追加は時間外に行う 

ユーザのダウンタイムと同期が取れない状態のリスクを最小限に抑えるために、アップグレードを時間外に実行することを強く

推奨します。 

すでに予約を含む既存のメールボックスを Cisco TMSXE の導入に追加する場合、1 回目の複製中に Cisco TMS のパフォーマン

スに予測される影響を考慮し、時間外に実行する必要があります。 

http://www.cisco.com/en/US/products/ps11338/products_installation_and_configuration_guides_list.html�
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ユーザにガイドを提供する 

WebEx Scheduling Mailbox または Cisco TelePresence フォームを導入する場合、詳細設定の動作に関する概要を簡単に理解
できるように、『Cisco TelePresence Management Suite Extension for Microsoft Exchange User Guide』のリンクをユーザに
提供することをお勧めします。 

メールボックスの設定と「Private」フラグ 

競合する設定を避けるため、Cisco TMSXE に追加されるすべての会議室のメールボックスは、予約件名とプライバシー設定を同
じ方法で処理するように設定する必要があります。つまり、次の設定をすべてのメールボックスに適用するか、どのメールボッ
クスにも適用しないか、いずれかにする必要があります。 

• 件名を削除する 

• 件名に主催者の名前を追加する  

• 承諾された会議のプライベート フラグを削除する 

ベスト プラクティスとして、セキュリティのために「Private」フラグを利用しないことを推奨します。承諾された会議のフラグ
を許可する場合は、必ずリソース カレンダーの開始アクセスを制限してください。そうしないと、ユーザは Outlook ですべての
会議情報を見ることができます。 

「Private」フラグは Outlook クライアント内では考慮されますが、Cisco TMS ではサポートされず、会議の件名は次の場所で
自由に表示できます。 

• Cisco TMS 
• 「Meetings」カレンダーをサポートするエンドポイント 

会議要求の本文と参加者のリストは、Cisco TMS に送信されません。 

Exchange で「Private」フラグを持つ予約の参加者または繰り返しパターンが Cisco TMS で変更された場合、これらの変更が 

Exchange に複製されると「Private」フラグは削除されます。 

メールボックスで必要な設定およびサポートされている設定の詳細な手順については、「必須設定の構成」（28 ページ）を参照
してください。 

自動検出の設定  

自動検出は CAS に障害が発生した場合の復元力を高めますが、Cisco TMSXE の起動時間が増えるというトレードオフがありま
す。大規模な導入では、起動時間が大幅に増加する場合があります。 

セキュアな通信 

サーバ間はセキュアな通信を使用することを推奨します。したがって、HTTPS がデフォルトの通信プロトコルであり、ソフト
ウェアをインストールする際、Cisco TMS と Exchange Web サービスの両方の通信に対して、構成ツールの [Use HTTP] 設
定はデフォルトで無効になります。 

この通信を適切に機能させるため、Cisco TMS と Exchange は両方とも有効な証明書を Cisco TMSXE に提示する必要があります。 

http://www.cisco.com/en/US/products/ps11472/products_user_guide_list.html�
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証明書の要件 

顧客ネットワークの信頼できる CA（認証局）から発行された証明書は、次の条件も満たす場合に有効な証明書と見なされます。 

• 証明書の発行対象であるマシンのホスト名と一致し、クライアントがサーバにアクセスするために使用するアドレスに一

致する。 

• 期限が切れていない。 

• 発行元 CA の期限が切れていない。 

• 会社の内部証明書ポリシーに準拠している。 

したがって、会社 CA は、Cisco TMS および Exchange 向けに、それらのアクセスに使用される URL、通常は FQDN に一致す

る証明書を発行する必要があります。 

証明書が有効であり機能しているかどうかを確認するには、次の手順を実行します。 

1. Cisco TMSXE サーバで Internet Explorer を起動します。 

2. Exchange CAS の URL を入力し、URL フィールドが緑色に変わることを確認します。 

3. Cisco TMS サーバの URL を入力し、URL フィールドが緑色に変わることを確認します。 

証明書に関する警告が表示されることは許容されません。 

信頼できない証明書 

上記の要件を満たさない証明書は信頼できないと判断され、実稼働設定には使用しないでください。 

初期設定時に、Cisco TMS および Exchange 用に検出された証明書が有効でなかった場合、構成ツールが管理者にプロンプトを

表示し、信頼できない証明書を許可することができます。この設定は元に戻すことができないため、テスト環境にインストール

する場合にのみ使用してください。 

すべての導入の制限事項 

ルーム メールボックスの代行者を使用することは Cisco TMSXE によりサポートされていますが、Outlook で生産性向上ツール

を使用している場合はサポートされていません。 

サポートされるシナリオと推奨設定の概要については、「代行者を設定したリソース メールボックスの準備」（26 ページ）を

参照してください。 

予約の制限事項 

期間が 3 分以内の会議を Outlook、Cisco TMS、またはその他の予約インターフェイスを経由して予約した場合、会議は Cisco 

TMSXE で処理されません。 

• 参加者人数が最初の MCU の容量を超えたときの追加の MCU へのカスケードは、サポートされていません。 
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このようなシナリオをサポートするには、Cisco TMS の優先 MCU として Cisco TelePresence Conductor を設定します。 

• サービス ユーザがすべての予約を実行する場合、予約の権限はすべてのユーザで同じです。Cisco TMS の個々の権限お

よび制限は無視されます。 

• 過去の会議を変更または削除することはできないので、会議を過去から未来に移動することはできません。 

• 既存の予約の編集時に使用可能なシステム ライセンスが十分でない場合、予約は削除されます。 

• 毎年の繰り返しはサポートされていません。 

予約の範囲と繰り返し 

Cisco TMS は、次のように予約範囲内にない、またはサポートされていない繰り返しパターンを持つ、会議出席依頼をすべて拒

否します。 

• 頻度が 100 を超える、または終了日を持たない一連の会議。 

• Cisco TMS 予約期間外の回を含む会議。Cisco TMS と Exchange 内のすべての統合されたリソース メールボックスに同

一の予約期間を設定することを強く推奨します。 

• 過去の会議。 

進行中の会議 

現在進行中の 1 つの会議を更新することはできますが、いつも失敗しないとは限りません。 

• 会議を変更する際、いずれかの参加者に対して予約の競合が生じる場合、会議の延長は失敗します。 

• 一連の会議の一部である会議を変更する際、次のようになります。 

• 開始時刻の編集は機能せず、Cisco TMS は例外をスローします。 

• 切断と再ルーティングを必要とするような会議の編集は正常終了しません。たとえば、会議が WebEx をサポート

しないブリッジを使用する場合、会議中に WebEx を追加できません。 

• 会議の他の要素はすべて変更できますが、参加者数が MCU または TelePresence Server の容量を超えると、

Cisco TMS は例外をスローし、参加者は追加されません。 

• 定例会議内の会議が進行中にその定例会議を削除すると、進行中の会議は終了します。 

• 定例会議内の会議が進行中にその定例会議を変更すると、次のように、進行中の会議を定例会議から分離して、単一の会

議に変えます。 

• 進行中の会議と競合する、変更された定例会議内の会議は作成されません。 

• 定例会議内の過去の会議はどれも変更されません。 

• 保留中の会議には新しい会議 ID が割り当てられます。 
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システムのアーキテクチャと概要 

System Overview 

 

Cisco TMSXE は Exchange Web Services（EWS）を使用して Exchange または Office 365 と通信します。 

Cisco TMSXE は、Web サービスを使用して、Cisco TelePresence Management Suite Extension Booking API（Cisco 

TMSBA）に予約要求を渡し、承認/拒否メッセージを受け取ります。 

使用するプロトコルによって、Cisco TMSXE はポート 80（HTTP 通信）またはポート 443（HTTPS 通信）を使用します。 

予約プロセス 

以下の項では、Outlook または Cisco TMS で予約が作成され、Cisco TMSXE を通じて複製されるしくみを説明します。 

「すべての導入の制限事項」（16 ページ）も参照してください。 
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Outlook から Cisco TMS へ 

1. Outlook を使用して、主催者は、1 つ以上のビデオ リソース（オプションで WebEx Scheduling Mailbox）を含む会議出

席依頼を作成し、[Send] をクリックします。 

主催者は自分のカレンダーまたはリソース カレンダーから予約できます。 

2. Exchange はリソース カレンダーで使用可能状況を確認し、次のいずれかを実行します。 

• リソースが予約されたことを示す初期確認を主催者に送信し、要求を Cisco TMSXE に渡します。 

• 使用可能なリソースがないことを主催者に通知します。 

このシナリオでは、Cisco TMSXE は連携されないので、主催者は予約（ステップ 1）を再度開始する必要があり

ます。 

• 1 つ以上のリソースが使用できないことを主催者に通知し、かつリソースの一部が予約されたことを示す初期確認

を主催者に送信します。これらのリソースの要求は Cisco TMSXE に渡されます。 

このシナリオでは、主催者は、会議時間を変更するか、または目的の時間に使用可能な他のリソースを検索するか

のいずれかを実行し、Outlook を使用して予約を変更する必要があります。 

3. Cisco TMSXE は Exchange からの要求を収集し、Cisco TMS に渡します。 

4. Cisco TMS は、関連するシステムおよび WebEx の使用可能状況を確認します。 

• 会議接続タイプの要求が [Automatic Connect]、[One Button to Push]、[Manual Connect]、または [No 

Connect] の場合、Cisco TMS は会議用にルーティング リソースの予約も試みます。 

• ただ 1 つのビデオ リソースが要求され、外部の参加者は要求されない場合、会議用に要求および保存された会議

接続タイプに関係なく、ルーティングは試行されません。 

• [Reservation] 接続タイプが要求された場合、ビデオ リソース（ルーム）は予約されますが、どのルーティング 

リソースも予約されません。 

• WebEx Scheduling Mailbox が会議に招待された場合、Cisco TMS は WebEx を含めることを試みます。 

5. 予約要求の結果を受け取ると、Cisco TMSXE は次のいずれかを実行します。 

• ルーティングが要求され、成功した場合、ルーティング情報は主催者に送信されます。 

• 1 つ以上のリソースを予約できない場合、またはルーティングが要求されたが成功しなかった場合、Cisco TMS 

は会議を [Defective] として保存します。このシナリオの詳細については、「問題のある会議」（20 ページ）を

参照してください。 

• ルーティングまたは WebEx が要求されず、すべてのリソースが予約できた場合、通知は送信されません。 

• WebEx が要求され、正常に予約された場合、参加するリンクおよびその他の WebEx 詳細は主催者への予約確認

に含まれます。 

• WebEx が予約できなかった場合、テレプレゼンス会議の予約確認には問題を示す WebEx エラー メッセージが含

まれます。 
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問題のある会議 

Cisco TMS で、問題のある会議とは、リソースの競合またはルーティングの問題が発生している外部クライアントによって予約

された会議です。 

問題のある会議では、予約要求のプロパティはすべて保持されますが、ルーティングが設定されたり、テレプレゼンス リソース

が消費されたりすることはありません。すべての問題が解決されるまで、Cisco TMS は問題のある会議を開始したり、エンドポ

イントに送信したりしません。 

• ルーティングの問題の場合は、予約に含まれるすべてのエンドポイントが、スケジュールされた時間に [Busy] に設定さ

れます。これにより、管理者またはユーザが問題を解決する間、予約が維持されます。 

• エンドポイントの予約が競合するまれなケースでは、問題のある予約に対してエンドポイントは [Busy] に設定されません。 

問題のある会議は、主催者または管理者が解決できます。 

• 会議が問題のある会議として保存されると、その会議を予約したユーザに電子メールで通知が送られます。ほとんどの問

題は、ユーザが各自のクライアントから要求を変更してスケジュールし直すことによって解決できます。 

• 管理者が問題のある会議を見つけて解決するには、Cisco TMS で、[Administrative Tools] > [Diagnostics] > 

[Conference Diagnostics] または [Booking] > [List Conferences] に移動します。 

問題のある会議の原因が、設定エラーまたはルーティング リソースの恒常的な不足にある場合は、管理者が問題を解決す

る必要があります。 

定期的な会議をスケジュールする際に、特定の回にのみリソースの競合またはルーティングの問題がある場合、Cisco TMS は、

問題のある回のみを問題のある会議として保存します。その他の回は影響を受けません。 

マスター参加者 

ビデオ会議マスターは、会議の議長とみなされる参加者で、手動で接続される会議を開始したり、より多くの時間が必要な場合

に会議を延長したりすることを求められます。この特性はすべてのエンドポイントのタイプでは使用できない機能に依存するた

め、すべてのエンドポイントがビデオ会議マスターになることはできません。 

Outlook から予約する場合、Cisco TMS は、エンドポイントがマスター参加者機能を持つことを条件に、[Location] フィールド

の最初のリソースをマスター参加者として設定します。最初のリソースがマスターになることができない場合、Cisco TMS は参

加者リストから別のエンドポイントを選択します。 

Cisco TMS から Exchange へ 

1. Cisco TMS Web インターフェイスを使用して、主催者は会議を予約します。 

2. Cisco TMSXE は 1 分おきに Cisco TMS をポーリングし、最後のポーリング以降の予約に対するすべての更新を取得し

ます。 

3. Cisco TMSXE は件名、会議室の参加者、Cisco TMS で会議を予約した人に関する情報を含むメッセージ本文など、

Outlook リソース カレンダー内の予約を作成または更新します。 
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次のように、Cisco TMS で会議が予約されたときのすべての会議プロパティが Exchange に複製されるわけではありません。 

• 詳細設定は複製されません。 

• 主催者とすべての参加者は [To:] フィールドに含まれません。 

• Cisco TMS で指定された場合、マスター参加者は [Location:] フィールドのルームの順序に反映されません。 

Cisco TMS を使用した Outlook 作成済み予約の更新 

Outlook で予約された会議が Cisco TMS を使用して更新されると、リソース カレンダーは更新されますが、Cisco TMSXE に個

人用メールボックスの予定表を変更する権限がないため、主催者の予定表は更新されません。 

Cisco TMS からルームが予約に追加されると、主催者は Outlook を使用してそれらを削除できません。 

複製の遅延 

Outlook から予約する場合、Cisco TMSXE は、会議に関するすべての情報を収集するために 1 分間待ってから、Cisco TMS に

予約を転送します。 

Outlook ユーザも変更した Cisco TMS の会議を更新する場合、次のように、Cisco TMSXE は、Cisco TMS からの変更をプッ

シュするために待機します。 

• Outlook で実行された変更が Cisco TMS にプッシュされている間。 

• 項目が Exchange で変更されずに 4 分間経過するまで。 

WebEx との通信 

• WebEx Productivity Tools with TelePresence は WebEx と直接通信します。したがって、WebEx Productivity Tools 

with TelePresence は、テレプレゼンスと WebEx の両方により、WebEx 専用会議のほか、CMR ハイブリッド会議の予

約に使用できます。 

• WebEx Scheduling Mailbox は、Cisco TMSXE/Cisco TMSBA/Cisco TMS により、WebEx と通信します。この方法を

使用して、WebEx を含めるかどうかがテレプレゼンス会議のプロパティとみなされます。 

この方法を使用して WebEx 専用の会議を予約することは可能ですが、テレプレゼンス参加者が予約されていない場合で

も MCU リソースが使用されるようになるので推奨されません。主催者は、予約確認でこのことを通知されます。 
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インストールまたはアップグレードの準備 
一部の手順は Cisco TMSXE のインストーラを実行する前に行う必要があります。手順はアップグレードであるか新規インス

トールの実行であるかにより異なり、使用する Microsoft Exchange のバージョンによっても異なります。 

バックエンドのバックアップとアップグレード 

インストールまたはアップグレードの前に、使用されるすべてのメールボックスをバックアップすることを強く推奨します。 

特に新規インストールの場合は、インストールの前に、テレプレゼンス ルーム メールボックスとして再利用される既存のすべて

のルーム メールボックスをバックアップすることを推奨します。 

Cisco TMSXE のインストールまたはアップグレードを開始する前に、Cisco TMS の必要なバージョンにアップグレードする必

要もあります。 

Cisco TMS のインストールまたはアップグレード 

Cisco TMSXE をインストールまたはアップグレードする前に、『Cisco TelePresence Management Suite Installation and 

Getting Started Guide』の手順に従って、Cisco TMS の必要なバージョン（14.4 が必須）をインストールします。 

Cisco TMS をアップグレードする場合は、次の手順を記載された順序で実行する必要があります。 

1. Cisco TMS データベースをバックアップします。 

2. 既存のインストールがある場合は Cisco TMSXE Windows サービスを停止します。 

3. 『Cisco TMS Installation and Upgrade Guide』の手順に従って、Cisco TMS をアップグレードします。 

4. このマニュアルの手順に従って、Cisco TMSXE をアップグレードします。 

14.2 より前のバージョン からの Cisco TMS のアップグレード 

14.2 より前の Cisco TMS バージョンからアップグレードし、別のタイム ゾーンからの予約に Cisco TMSXE を使用する場合、

Cisco TMSXE のこのバージョンのインストールに必要な Cisco TMS のバージョンにアップグレードする前に、14.3.2 にアップ

グレードし、タイム ゾーン更新ツールを実行して予約のタイム ゾーン データを修正する必要がある場合があります。 

タイム ゾーン更新ツールの操作方法とこのツールを実行する必要のあるユーザの詳細については、『Cisco TMS Installation and 

Upgrade Guide』を参照してください。 

新規インストールの準備 

Cisco TMSXE の新規インストールを実行するオプションは、前の 3.x バージョンがない場合だけです（すでに Cisco TMSXE 

3.x をインストールしている場合、インストーラを実行するとアップグレードが求められます）。 

http://www.cisco.com/en/US/products/ps11338/prod_installation_guides_list.html�
http://www.cisco.com/en/US/products/ps11338/prod_installation_guides_list.html�
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次の場合は 5.0 のクリーン インストールを実行します。 

• Cisco TMSXE の既存の導入がない。 

• Cisco TMSXE の動作のしくみを確認するために、テスト環境または導入をセットアップしたい。 

既存の導入が存在する場合、管理者によるアップグレードを強く推奨します。 

Active Directory での Cisco TMSXE サービス ユーザの作成 

Exchange 管理コンソールで、選択したユーザ名とパスワードを使用して、Cisco TMSXE のサービス ユーザとして新しいユー

ザのメールボックスを作成します。このサービス ユーザにより、Cisco TMSXE は Exchange および Cisco TMS に接続できます。 

Cisco TMSXE 用の Cisco TMS ユーザの作成 

1. Cisco TMS で、[Administrate Tools] > [User Administrations] > [Users] に移動します。 

2. [New] をクリックします。 

3. 過去に作成した Cisco TMSXE サービス ユーザの詳細を追加します。 

4. Cisco TMS の権限はグループ レベルで制御されます。次のいずれかを実行する必要があります。 

• 権限の小規模なサブセットを持つグループにアカウントを追加します。次の「最小限必要な権限の設定」

（23 ページ）を参照してください。 

• ユニバーサル アクセス権を持つサイト管理者グループにサービス ユーザを追加します。 

サービス ユーザには、統合システムごとに予約権限も必要です。これは Cisco TMS のすべてのデフォルト ユーザ グループにつ

いてデフォルトで有効になっています。 

最小限必要な権限の設定 

Cisco TMSXE がエンドポイントを予約し、Cisco TMS から予約情報にアクセスできるように、サービス ユーザをサイト管理者

または次の権限を持つグループのメンバーにする必要があります。 

• [Systems] > [Navigator] > システムを選択 > [Folder and System Permissions] > [System Permissions] の下の 

[Read] および [Book] 

• Cisco TMS フォルダ構造のシステムの上にあるすべてのフォルダに対して、[Systems] > [Navigator] > フォルダを選

択 > [Folder and System Permissions] > [Folder Permissions] の下の [Read] 

Cisco TMS ユーザ グループの権限を表示または変更するには、次の手順を実行します。 

1. [Administrative Tools] > [User Administration] > [Groups] に移動します。 

2. 目的のグループ上にカーソルを置き、ドロップダウン矢印をクリックして [Set permissions] を選択します。 

3. [Booking] で、次の権限が有効になっていることを確認します。 
• List Conferences - All  

• Read 
• Update 
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• その他 
• Booking 
• Book on behalf of 
• Approve Meeting 

4. 変更した場合は、[Save] をクリックします。 

デフォルトの会議設定の指定 

予約インターフェイスに関係なく、すべての予約に使用されるデフォルト設定は Cisco TMS で指定されます。これらの設定は 

Outlook からの主催者の予約に対して透過的ではありません。したがって、組織内のユーザまたは主催者にこれらのデフォルト

を伝えることを推奨します。 

デフォルトの会議設定を変更するには、次の手順を実行します。 

1. [Administrative Tools] > [Configuration] > [Conference Settings] に移動します。 

2. すべてのデフォルト設定が希望どおりに設定されていることを確認します。設定のフィールド レベルの説明については、

組み込みのヘルプを参照してください（右上隅にある疑問符をクリックします）。 

3. WebEx Productivity Tools with TelePresence または Cisco TelePresence フォームを使用しない場合は、次のように、

[Default Reservation Type for Scheduled Calls] フィールドに特に注意してください。 

• すべてのスケジュール済み会議が会議の開始時刻に自動的にルーティングおよび接続されるようにするには、

[Automatic Connect] に設定します。 

• コールを設定しても自動的に起動しないようにする場合は、[One Button to Push] または [Manual Connect] を選

択します。 

• 設定が [Reservation] の場合、主催者が Cisco TelePresence フォームを使用して異なる会議タイプを指定しない

限り、ルーティング リソースはスケジュールされません。 

4. [Save] をクリックして変更を適用します。 

デフォルトで WebEx を含める 

Cisco TMSXE の予約は、[Administrative Tools] > [Configuration] > WebEx 設定にある Cisco TMS の WebEx 設定の影響も

受けます。 

[Add WebEx To All Conferences] フィールドによって、Cisco TMS はすべての予約に WebEx を含めることになり、Outlook か

ら予約する主催者は、予約の確認を受け取るまで WebEx が含まれていることに気付かない場合があることに注意してください。 

会議ごとの設定 

WebEx Productivity Tools with TelePresence またはカスタムの Cisco TelePresence 予約フォームを使用する場合、主催者は

会議ごとにこれらの設定の一部を変更できます。 

フォームの展開の詳細については、「Cisco TelePresence 詳細設定フォームの導入」（52 ページ）を参照してください。 
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WebEx Productivity Tools with TelePresence 向け Cisco TMSXE の設定の詳細については、「Cisco TMSXE を使用した 

WebEx Productivity Tools with TelePresence の設定」（50 ページ）を参照してください。 

ユーザに対する予約のしくみの詳細については、『Cisco TelePresence Management Suite Extension for Microsoft Exchange 

User Guide (5.0)』を参照してください。 

Exchange での Cisco TMS エンドポイントのメールボックスの作成 

Cisco TMSXE にエンドポイントを追加するには、その前に、Exchange でこれらのエンドポイントがルーム メールボックスに

よって示されている必要があります。 

PowerShell、Exchange 管理センター、または Exchange 管理コンソールを使用して、boardroom@example.com などのエンド

ポイントごとに 1 つのルーム メールボックスを作成します。 

ルーム メールボックスの作成方法の詳細については、次を参照してください。 

• Office 365 and Exchange 2013：Create and Manage Room Mailboxes 

• Exchange 2010：Create a Room or Equipment Mailbox 

• Exchange 2007：How to Create an Equipment Mailbox 

Cisco TMSXE の設定を簡素化するために、メールボックス名としてエンドポイントの Cisco TMS 表示名（スペースがある場合

はすべて削除）を使用することを推奨します。 

すべてのルーム メールボックスは適切な設定および権限で構成する必要があります。使用する Exchage バージョンに対する手

順については、「ルーム メールボックスの設定」（26 ページ）を参照してください。 

既存のメールボックスの再利用 

エンドポイントがすでにルーム メールボックスを持つ会議室の場合、そのメールボックスを Cisco TMSXE の予約に再利用でき

ます。 

再利用されたメールボックス内のすべての予約は Cisco TMSXE の起動時に Cisco TMS に複製されることに注意してください。

これらの予約のいずれかが失敗すると、電子メール通知を主催者に送信するかどうかを決定するためのオプションが表示されま

す。過去の予約はいずれも複製されません。 

再利用されるメールボックスは、「ルーム メールボックスの設定（26 ページ）」の手順に従って設定する必要もあります。 

Office 365 で使用するための PowerShell の設定 

Cisco TMSXE で使用するためにメールボックスを設定するには、Microsoft の次の手順に従って、Windows PowerShell が 

Office 365 と連携できるようにする必要があります。 

1. Windows PowerShell のインストールと設定 

2. Windows PowerShell のサービスへの接続 

http://technet.microsoft.com/en-us/library/jj215781(v=exchg.150).aspx�
http://technet.microsoft.com/en-us/library/bb124952(v=exchg.141).aspx�
http://technet.microsoft.com/en-us/library/bb124925(v=exchg.80).aspx�
http://help.outlook.com/en-us/140/cc952756.aspx�
http://help.outlook.com/en-us/140/cc952755.aspx�
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ルーム メールボックスの設定 

この項では、Cisco TMSXE で使用するルーム メールボックスの設定に必要な手順について説明します。 

これらの手順は次のシナリオで必要です。 

• 新規または再利用されたリソース メールボックスを使用する新規インストール 

• アップグレード時に導入に追加される 1 つ以上の新規システム 

Cisco TMSXE 3.x からアップグレードする管理者は、メールボックスを再設定する必要はありませんが、以下で説明するように、

すべてのリソース メールボックスが正しく同様に設定されていることを確認することをお勧めします。 

ほとんどの不正なメールボックスの設定に対して、構成ツールは警告をポップアップし、エラーはイベント ログに書き込まれま

す。[AutoAccept] がオンになっていない場合、Cisco TMSXE のログに INFO メッセージとして記録されることに注意してくだ

さい。 

以下の必須の設定に加えて、ユーザに最低限の読み取りアクセス権を付与するようにルーム メールボックスを設定し、主催者が

予約時に空き/使用中の情報を入手可能にすることを推奨します。 

代行者を設定したリソース メールボックスの準備 

ルーム メールボックスの代行者を使用することは Cisco TMSXE によりサポートされていますが、Outlook で生産性向上ツール

を使用している場合はサポートされていません。 

Cisco TMSXE は、以下の 3 つの代行設定についてテスト済みです。 

• 電子メールベース：ユーザまたはグループはリソース メールボックスの代行者として定義され、招待がユーザに転送され

ます。代行者は自身のメールボックスから招待を承諾または辞退できます。 

• カレンダーベース：ユーザまたはグループは、エディタ権限を持つリソース メールボックスの代行者として定義され、招

待がユーザに転送されます。代行者は、リソース カレンダーで直接招待を承諾または辞退します。 

• ルーム管理者：ユーザはリソース メールボックスへの最小限のエディタ権限を持つルーム管理者として定義され、リソー

ス カレンダーで既存の会議を編集したり、新しい会議をカレンダーで直接作成したり、新しい会議の招待を承諾または拒

否する権限が与えられます。 

代行者の設定に関係なく、Cisco TMSXE では二重予約はサポートされません。 

代行者またはルーム管理者を持つメールボックスの推奨設定は次のとおりです。: 

AutomateProcessing：AutoAccept 

AllowConflicts：False 

ForwardRequestsToDelegates：True 

TentativePendingApproval：True 
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ResourceDelegates：(list of delegate users) 

RequestOutOfPolicy：{} 

AllRequestOutOfPolicy：False 

BookInPolicy：{} 

AllBookInPolicy：False 

RequestInPolicy：{} 

AllRequestInPolicy：True 

偽装とスロットリングの設定 

Office 365、Exchange 2013、および Exchange 2010 

リクエストでのスロットリングの問題を回避し、サービス ユーザに必要な権限を付与するために、Cisco TMSXE の設定中およ

び Exchange においてサービス ユーザに対して偽装を有効化する必要があります。 

偽装をセットアップするには、次の手順を実行します。 

1. シェル コマンドレット New-ManagementRoleAssignment を使用して、次のコマンドを実行します。 

New-ManagementRoleAssignment –Name:impersonationAssignmentName –
Role:ApplicationImpersonation –User:[ServiceUser] 

2. Cisco TMSXE 向けに Exchange Web サービスを設定する際は、[Service User Impersonation] を必ず有効にしてくだ

さい。 

これにより、サービス ユーザは組織内の他のすべてのユーザを偽装できます。制限を設定するには、Exchange で管理スコープ

を使用します。このために新しいスコープを作成するか、または既存のスコープを使用できます。 

管理スコープと偽装に関する Microsoft の手順および詳細については、次を参照してください。 

• Exchange の偽装の設定 

• ApplicationImpersonation ロール 

Exchange 2010 の代替 

Exchange 2010 の場合、代わりにサービス ユーザのすべてのリソースのメールボックスにフル アクセス権限を付与し、スロッ

トリング ポリシーを適用することで、偽装を使用しないことを選択できます（両方ともこの段階で実行する必要があります）。

手順については、「メールボックスの偽装を使用しない Exchange 2010 の設定」（76 ページ）を参照してください。 

http://msdn.microsoft.com/en-us/library/office/bb204095(v=exchg.140).aspx�
http://technet.microsoft.com/en-us/library/dd776119(v=exchg.150).aspx�
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Exchange 2007 

Exchange 2007 の場合、サービス ユーザのフル アクセス権限をセットアップする必要があります。偽装はサポートされていません。 

Exchange 2007 に対して フル アクセス権限を設定するには、Exchange 管理コンソールまたは Exchange 管理シェルの使用と

いう 2 つの方法があります。 

Exchange 管理コンソールで次の手順を実行します。 

1. EMC ツリーを使用して、[Recipient Configuration] > [Mailbox] に移動し、設定するメールボックスを選択します。 

2. ルーム メールボックスを右クリックし、[Manage Full Access Permission...] を選択します。 

3. Cisco TMSXE サービス ユーザを追加します。 

4. 以下の Exchange 管理シェルの手順に進みます。 

Exchange 管理シェルを使用する場合、次のコマンドを入力します。ここで、[mailbox] を設定するメールボックスで置き換え

ます。@ 記号およびドメインは含めません。 

Add-MailboxPermission [mailbox] -User "[service user]" -AccessRights FullAccess.  

必須設定の構成 

必ずすべてのメールボックスを同様に設定し、下表に示されている要件に従っていることを確認してください。 

メールボックス間で設定に違いがある場合、Cisco TMS および Exchange 間の不一致が発生する可能性があります。 

シェル パラメータ 必要な値 説明 

AutomateProcessing AutoAccept 自動的に招待を処理するようにメールボックスを設定します。 

BookingWindowInDays 1 ～ 1080 の範囲内で

ある必要があります。

推奨値については説明

を参照してください。 

将来、ユーザが会議をスケジュール化できる期間を指定します。

この設定は、次の手順で参照可能な Cisco TMS の設定と一致さ

せることを推奨します。[Administrative Tools] > 
[Configuration] > [Conference Settings] > [Conference 
Create Options] > [Booking Window (in days)] 

EnforceSchedulingHorizon True 予約期間の外に継続する定期的な会議が拒否されることを指定し

ます。 

AllowConflicts False メールボックスが Cisco TMS でサポートされない重複の予約を

受け入れることを防ぎます。 

ConflictPercentageAllowed  これら 2 つの設定は、AllowConflicts が False である限り、

任意の値に設定できます。 

既存の予約と競合している繰り返しシリーズのすべての回は、

予約が Cisco TMSXE および Cisco TMS によって処理される前

に、例外として Exchange によって削除されます。 

MaximumConflictInstances  
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シェル パラメータ 必要な値 説明 

DeleteSubject False（推奨）または 
True 

会議の件名を削除するためにオプションを無効にすることを推奨

します。ただし、このオプションを有効にすることが一部のルー

ム メールボックスの要件である場合、すべてのメールボックス

に対して True に設定する必要があります。 

AddOrganizerToSubject False または True メールボックスが予約の件名に主催者の名前を追加しないように

設定します。オプションで、すべてのメールボックスに対して、

これを True に設定できます。 

この設定と件名を削除する設定の両方を有効にすると、Cisco 

TMS および Cisco TMSXE では会議の件名が空になることに注

意してください。 

RemovePrivateProperty True（推奨）または 
False 

この設定は、メールボックスで受け入れられたすべての会議の

「Private」フラグを削除します。設定を有効にする必要はありま

せんが、Cisco TMSXE に追加されたすべてのメールボックスで

同じである必要があります。「Private」フラグは Cisco TMS で

サポートされないことにも注意してください。詳細については、

「すべての導入のベスト プラクティス」を参照してください。 

CalendarRepairDisabled 
(Set-Mailbox) 

True（強く推奨） メールボックスの Calendar Repair Assistant（CRA）を無効にし

ます。この設定を変更するための GUI オプションはありません。 

CRA は Exchange 2010 ではデフォルトで無効になり、Office 

365 を含む新しいバージョンではデフォルトで有効です。 

 

上記の設定の詳細については、次を参照してください。 

• Configure Resource Mailbox Options in Windows PowerShell (Office 365 Help) 
• Configure User and Resource Mailbox Properties (Exchange 2010 Help) 
• Set-MailboxCalendarSettings (Exchange 2007 Help) 

上記の設定がアクティブであることを確認するには、次の手順を実行します。 

• 次のシェル コマンドを使用します。Get-CalendarProcessing -id [mailbox] | fl 

• Calendar Repair Assistant が無効であることを確認するには、次のコマンドを使用します。Get-Mailbox -id 
[mailbox] | ft CalendarRepairDisabled 

• Exchange 2007 の場合、次のシェル コマンドを使用します。Get-MailboxCalendarSettings - id [mailbox] | fl 

上記のコンソール設定の詳細については、Microsoft TechNet の記事を参照してください。 

http://help.outlook.com/en-us/140/dd569932.aspx�
http://technet.microsoft.com/en-us/library/bb124255.aspx�
http://technet.microsoft.com/en-us/library/aa996340(EXCHG.80).aspx�
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Cisco TMSXE 5.0 へのアップグレード 

Cisco TMS がバージョン 14.4 または 14.4.1 の場合のアップグレード 

Cisco TMS および Cisco TMSXE をアップグレードし、前者がバージョン 14.4 または 14.4.1 の場合、次の手順を実行します。 

• Cisco TMS をアップグレードする前に、クラスタ化されている場合は両方のノードで、Cisco TMSXE サービスを無効に

します。 

• Cisco TMS および Cisco TMSXE の両方がすべてのサーバまたはノードでアップグレードされたら、サービスを開始します。 

3.1 よりも前のバージョンからのアップグレード 

• 3.0.x バージョンから Cisco TMSXE をアップグレードした後、Cisco TMS と Exchange リソース メールボックスの間で

不一致をクリーンアップするために、起動時に Cisco TMS のすべての予約の再複製が実行されます。 

Cisco TMS データベースのサイズと予約の数に応じて、この処理が完了するまでに非常に長い時間がかかる場合がある

ため、アップグレードは時間外に実行することを強く推奨します。 

再複製のモニタリングの詳細については、「付録 3：3.0.x からアップグレードする際の再複製のモニタリング」を参照

してください。 

• Cisco TMSXE 2.x からの移行はサポートされていません。 

現在 Cisco TMSXE 2.x を実行中のお客様は、Cisco TMSXE の移行に必要なツールを含む、Microsoft Exchange 2010 

および Cisco TMSXE 3.0.2 に移行する必要があります。その後、最新バージョンにアップグレードできます。 

ご使用になる前に 

次のことを確認してください。 

• すべての「前提条件」（2 ページ）が満たされている。 

• 「すべての導入のベスト プラクティス」（14 ページ）を考慮した。 

• 「バックエンドのバックアップとアップグレード」（22 ページ）の手順に従った。 

• インストール サーバ上でローカル管理者としてログインしている。 

クラスタ化された導入にアップグレードする場合は、「サービス クラスタリングを持つ Cisco TMSXE のインストール」

（41 ページ）を参照してください。 

インストーラの実行 

1. クラスタ化された導入をアップグレードする場合、両方のノードで Cisco TMSXE Windows サービスを停止します。 
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2. Windows Update を確認し、Cisco TMSXE がインストールされたサーバ上の .NET Framework にすべての重要な更新を

インストールします。.NET バージョンが 4.0 以降であることを確認します。インストール後に操作を求められた場合は

サーバをリブートします。 

3. サーバ上にインストール ファイルを配置します。 

4. Cisco TMSXE インストーラを実行し、エンドユーザ使用許諾契約書（EULA）に同意して、インストール プロセスを開

始します。 

5. インストーラは Cisco TMSXE の以前のインストールを検出します。[Upgrade] をクリックして続行します。 

6. [Next] をクリックしてセットアップを開始します。 

7. 使用許諾契約書の条項に同意し、[Next] をクリックします。 

8. 次のように、インストールを含めるコンポーネントを選択します。 

• TelePresence 付き WebEx 生産性向上ツールの使用を計画している場合、Cisco TMS 予約サービスが必要です。 

これを有効にした場合、予約サービスをインストールする IIS アプリケーション プールの名前の変更または確

認が求められます。詳細については、「Cisco TMSXE での TelePresence の WebEx 生産性向上ツールのセッ

トアップ」（50 ページ）を参照してください。 

• 冗長性について Cisco TMSXE をセットアップする場合、Cisco TMSXE クラスタリングが必要です。クラスタ化

された導入へのアップグレード手順の詳細については、「サービス クラスタリングを持つ Cisco TMSXE のイン

ストール」（41 ページ）を参照してください。 

• Performance Monitor を有効にし、標準の Windows ツールを使用して Cisco TMSXE のパフォーマンスをモニタ

できるようにすることができます。 

9. 以前のバージョンの Cisco TMSXE が現在インストールされている場合は、アップグレードを求めるプロンプトが表示さ

れます。 

o [Yes] をクリックして続行します。アップグレードにより、古いバージョンが削除され、既存の Cisco TMS デー

タベースがアップグレードされます。 

o [No] をクリックするとインストールが中断され、現在のインストールはそのままの状態になります。 

10. アップグレードが完了したら、[Finish] をクリックします。 

11. 構成ツールを起動します。 

Cisco TMSXE の設定 

1. 設定ウィザードをクリックで進め、必要に応じて設定の変更およびシステムの追加を行います。 

2. 以前のバージョンからのすべての設定が維持され、[Next] をクリックすると再検証されます。 

3. Exchange Web サービスの手順で、次のように、新しい設定の構成を選択できます。 

• 自動検出 CAS。これを有効にすると、[Server Address] フィールドが無効になり、ユーザの Exchange 環境で有

効になっている自動検出が使用されることに注意してください。 
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• リソース メールボックス偽装。フル メールボックス アクセスの必要性がなくなりますが、Exchange 2007 では

サポートされていません。 
• WebEx Scheduling Mailbox 

 

4. すべての設定を検証したら、[Finish] をクリックします。 

Cisco TMSXE サービスを開始するかどうかの入力が求められます。 

• クラスタ化された導入をアップグレードする場合は拒否して、第 2 のノードについて上記の手順を繰り返してか

ら、両方のノードでサービスを開始します。 

• 拒否した場合は、準備が整った時点で、「Cisco TMSXE サービスの開始および停止」（56 ページ）の手順に従

い、サービスを手動で開始する必要があります。 

新規インストールの実行 

この項では、以前の Cisco TMSXE が導入されていない場合の Cisco TMSXE 5.0 のインストール手順について説明します。 
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ご使用になる前に 

次のことを確認してください。 

• すべての「前提条件」（2 ページ）が満たされている。 

• 「すべての導入のベスト プラクティス」（14 ページ）を考慮した。 

• 「新規インストールの準備」（22 ページ）に説明されているすべての手順を完了した。 

• インストール サーバ上でローカル管理者としてログインしている。 

クラスタ化された導入をセットアップする場合は、「サービス クラスタリングを持つ Cisco TMSXE のインストール」

（41 ページ）を参照してください。 

インストーラの実行 

1. Windows Update を確認し、Cisco TMSXE がインストールされたサーバ上の .NET Framework にすべての重要な更新を

インストールします。.NET バージョンが 4.0 以降であることを確認します。インストール後に操作を求められた場合は

サーバをリブートします。 

2. サーバ上にインストール ファイルを配置します。 

3. Cisco TMSXE インストーラを実行し、エンドユーザ使用許諾契約書（EULA）に同意して、インストール プロセスを開

始します。 

4. 次のように、インストールを含めるコンポーネントを選択します。 

• TelePresence 付き WebEx 生産性向上ツールの使用を計画している場合、Cisco TMS 予約サービスが必要です。 

これを有効にした場合、予約サービスをインストールする IIS アプリケーション プールの名前の変更または確

認が求められます。詳細については、「Cisco TMSXE での TelePresence の WebEx 生産性向上ツールのセッ

トアップ」（50 ページ）を参照してください。 

• 冗長性について Cisco TMSXE をセットアップする場合、Cisco TMSXE クラスタリングが必要です。クラスタ化

された導入へのアップグレード手順の詳細については、「サービス クラスタリングを持つ Cisco TMSXE のイン

ストール」（41 ページ）を参照してください。 

• Performance Monitor を有効にし、標準の Windows ツールを使用して Cisco TMSXE のパフォーマンスをモニタ

できるようにすることができます。 

5. 導入に適したコンポーネントを選択したら、[Next] をクリックします。 

6. [Install] をクリックします。 

7. インストールが完了したら、[Finish] をクリックしてインストーラ ウィンドウを閉じ、Cisco TMSXE 構成ツールを起動

します。 
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Cisco TMSXE の設定 

構成ツールのほとんどのフィールドは必須です。[Next] をクリックすると、初期設定の各手順で指定された設定が検証されます。

1 つ以上の設定が検証できない場合、前の手順に戻って修正することができます。 

この手順は、設定プロセスの各ステップを示します。使用可能な各フィールドの詳細については、「設定の参照先」（37 ページ）

を参照してください。 

1. 最初のステップでは Cisco TMS の接続の詳細を入力し、認証方法を決定します。 

HTTPS を使用するように Cisco TMS を設定していない場合は、必ず [Use HTTP] をチェックしてください。 

Cisco TMS にネットワーク ロード バランサを備えた冗長設定を使用する場合、ネットワーク ロード バランサの仮想ア

ドレスをここに入力します。 
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2. Exchange Web サービスの場合、すべての接続詳細を指定します。 

• 使用環境でセットアップされている場合は、[Autodiscover CAS] を有効にします。または、Exchange クライアン

ト アクセス サーバ（CAS）のアドレスを含めます。これにより、[Server Address] フィールドが無効になります。 

• サービス ユーザ用のフル メールボックス アクセスがない Exchange 2013 または Exchange 2010 を使用する場

合、[Resource Mailbox Impersonation] を有効にします。 

• また、認証方法を決定する必要もあります。 

 

[Next] をクリックして設定内容を送信します。接続に失敗した場合、トラブルシューティングのために Exchange Web 

Services（EWS）のログを表示するオプションが提示されます。 

表示したログは閉じて、[Return to Settings] をクリックし、エラーを修正してから再送信します。 

3. システム設定手順には、統合可能な Cisco TMS のすべてのエンドポイントのリストが含まれます。 

ルーム メールボックスがすでに Exchange で使用可能である必要があることに注意してください。そうでない場合、こ

のステップの検証は失敗します（「Exchange での Cisco TMS エンドポイントのメールボックスの作成」（25 ページ）

を参照） 

Cisco TMSXE にシステムを追加するために、次の処理を実行できます。 

• 「システム インポートおよびエクスポート」（39 ページ）で説明しているファイル形式に準拠した .csv ファイ

ルから、メールボックスとシステムのリストをインポートします。 
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• 次のように、システムを 1 つずつ追加します。 

1. 電子メール アドレスのパターンを変更して、ルーム メールボックスの名前を生成します。ルーム メール

ボックスのプライマリ SMTP アドレスを使用します。エイリアスはサポートされていません。次の 2 つの

オプション変数を使用できます。 

• {{TmsId}} は Cisco TMS からシステムの数値システム ID に変換されます。 

• {{DisplayName}} は Cisco TMS のシステムの表示名に変換されます。表示名にスペースが含ま

れる場合は、すべて自動的に削除されることに注意してください。 

2. 左側のリストからエンドポイントを選択し、[>>] をクリックして、Cisco TMSXE に追加します。Ctrl 

または Shift を選択して、複数のエンドポイントを選択します。 

3. 右側のリストに追加された個々の電子メール アドレスを、必要に応じてダブルクリックして変更します。 

新しいメールボックスとシステムの間の初回の複製時に主催者に通知するかどうかも選択する必要があります。初回の複

製時に Cisco TMS との競合または不一致がある場合、Exchange の予約は次のように処理される可能性があります。 

• 競合または不一致によりキャンセルされる。 

• 競合または不一致により、ルーティングなしの [Reservation] にダウングレードされる。ダウングレードされた会

議の詳細については、「新しいシステム通知」（40 ページ）を参照してください。 

 

[Next] をクリックして、システムとメールボックスの検証に進みます。システムの数が多い場合はしばらく時間がかかる

場合があることに注意してください。250 個のエンドポイントで、この処理には約 90 秒かかることがあります。 

4. [Location] で、ログ、データ、およびコンフィギュレーション ファイルのデフォルト フォルダを使用することを確認す

るか、または必要に応じて変更します。 
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件名を削除して、主催者の名前を件名に追加するように、メールボックスを設定してある場合、主催者の名前の処理方法

を決定します。「Cisco TMS 会議タイトルに主催者を表示しない」（41 ページ）を参照してください。 

 

5. 次のステップで、設定プロセスが完了したことを確認します。[Finish] をクリックします。Cisco TMSXE サービスを開始

するかどうかの入力が求められます。 

6. サービスを開始すると、Cisco TMS と Cisco TMSXE 間の初回の複製が起動します。 

• 複製中は Cisco TMS のパフォーマンスが影響を受けるため、追加されたすべてのシステム設定が Cisco TMS で

完了し、メンテナンス時間がある場合にだけ、ただちにサービスを開始します。 

• この時点でサービスを開始する準備ができていない場合は拒否し、Cisco TMSXE の開始準備ができたら、

「Cisco TMSXE サービスの開始および停止」（56 ページ）の手順に従います。 

設定プロセス中にすべての検証手順が失敗した場合は、「設定中のエラー」（66 ページ）の項を参照してください。 

設定の参照先 

表 5 構成ツール フィールド リファレンス 

フィールド 説明 

Cisco TMS  

Server Address これは Cisco TMS サーバの IP アドレスまたは完全修飾ドメイン名（FQDN）です。プロトコル（HTTP 

または HTTPS）を含めないでください。コロンと特定のポート番号を含めることができます。 

証明書によるセキュアな接続を使用する場合は、FQDN を指定する必要があります。 
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フィールド 説明 

Cisco TMS にネットワーク ロード バランサを備えた冗長設定を使用する場合、ネットワーク ロー
ド バランサの仮想アドレスをここに入力します。 

Use HTTP Cisco TMS との通信では、暗号化はデフォルトで使用されます。このオプションは Cisco TMS と
のセキュアな通信を無効にします。 

Username Cisco TMSXE サービス ユーザが Cisco TMS にログインするために作成したユーザ名。詳細につ
いては、「Active Directory での Cisco TMSXE サービス ユーザの作成」（23 ページ）を参照し
てください。 

Password 上記ユーザのパスワード。 

Domain Cisco TMS サーバのあるドメイン。 

Exchange Web 
サービス 

 

CAS Autodisover Exchange CAS（クライアント アクセス サーバ）の自動検出を許可するかどうかを指定します。
この機能は、ドメインで設定される自動検出サービスに依存します。 

Service User Email 自動検出機能を使用する場合、Cisco TMSXE サービス ユーザの完全な電子メール アドレスを指定しま
す。「Active Directory での Cisco TMSXE サービス ユーザの作成」（23 ページ）を参照してください。 

Server Address 自動検出機能を使用しない場合、Exchange クライアント アクセス サーバ（CAS）のアドレス
を、完全修飾ドメイン名（FQDN）で指定します。 

• プロトコル（HTTP または HTTPS）を含めないでください。 

• コロンと特定のポート番号を含めることができます。 

Use HTTP Exchange Web サービスとの通信では、暗号化はデフォルトで使用されます。このオプションは 

EWS とのセキュアな通信を無効にします。 

Sender Email Address Cisco TMSXE を使用して予約する主催者へのすべての通知の [From:] アドレスとして使用される
電子メール アドレス。Cisco TMSXE サービス ユーザの電子メール アドレスを使用する場合は空
白のままにします。 

主催者が返信可能なアドレスから通知を受信できるようするために、サポート用電子メール アドレ
スまたは同様のアドレスをここに追加できます。サービス ユーザにこのアドレスの Send as 権限
を付与する必要があることに注意してください。次を参照してください。 

• Office 365：Manage Permissions for Recipients 

• Exchange 2013：Add-ADPermission 

• Exchange 2010：Manage Send As Permissions for a Mailbox 

• Exchange 2007：How to Grant the Send As Permission for a Mailbox 

WebEx Scheduling 
Email 

WebEx Scheduling Mailbox のアドレス。詳細については、「WebEx Scheduling Mailbox のセッ
トアップ」（47 ページ）を参照してください。 

http://technet.microsoft.com/en-us/library/jj919240(v=exchg.150).aspx�
http://technet.microsoft.com/en-us/library/bb124403(v=exchg.150).aspx�
http://technet.microsoft.com/en-us/library/bb676368.aspx�
http://technet.microsoft.com/en-us/library/aa998291(EXCHG.80).aspx�
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フィールド 説明 

Resource Mailbox 
Impersonation 

1 つアカウントからの多数のコールによるスロットル問題を回避するために、Exchange と通信す
る際に、Cisco TMSXE サービス ユーザがルーム メールボックスを偽装するかどうかを指定しま
す。この設定は、Office 365 では必須であり、Exchange 2013 および 2010 で推奨されます。 

（注） 

• Exchange 2010 では、代わりにスロットル ポリシーを選択できます。「メールボックスを
偽装しない Exchange 2010 の設定」（76 ページ）を参照してください。 

• Exchange 2007 では、偽装はサポートされません。サービス ユーザにフル アクセス権限を
付与する必要があります。「偽装およびスロットルのセットアップ」（27 ページ）を参照し
てください。 

Username and 
password 
authentication 

Exchange および Active Directory で作成されたサービス ユーザのユーザ名とパスワードで認証し
ます。「Active Directory での Cisco TMSXE サービス ユーザの作成」（23 ページ）を参照して
ください。 

• [Username]：Exchange および Active Directory での Cisco TMSXE サービス ユーザ。 

• [Password]：上記ユーザのパスワード。 

• [Domain]：Exchange サーバが存在するドメイン。 

Client certificate 
authentication 

クライアント証明書およびパスワードで認証します。 

• [Certificate]：Exchange での認証に使用するクライアント証明書を参照します。この認証モード
を使用する際の前提条件については、「証明書の認証」（10 ページ）を参照してください。 

• [Password]：上記証明書のパスワード。 

Systems  

Email Pattern • 電子メール パターンを作成する際、オプションの変数 {{TmsId}} および {{DisplayName}} 

は、それぞれ Cisco TMS のエンドポイントの [TMS System ID] および [Display Name] に
変換されます。表示名の中に空白がある場合はすべて自動的に削除されます。 

• 追加するシステムが多数ある場合に設定を簡略化するために、メールボックス名として 

Cisco TMS 表示名を使用することを推奨します。手順については、「Exchange での Cisco 

TMS エンドポイントのメールボックスの作成」（25 ページ）を参照してください。 

• 電子メール ドメインのデフォルトは使用中のドメインになります。 

• 組織のメールボックス名がこのようなパターンで表すことができない場合、各電子メール ア
ドレスはこの設定タブの右側のリストに追加された後で手動で編集できます。 

System Import and 
Export 

リストにメールボックスを 1 つずつ追加する代わりに、メールボックスとそれらに関連付ける 

Cisco TMS システムのカンマ区切りリストをインポートできます。 

リストは .csv ファイルとして保存する必要があり、有効な形式は次のとおりです。ここで、ヘッ
ダ行と [System Name] フィールドはオプションで、2 番目の行は次のような値を含みます。 

TMS ID, System Name,Email 42,Meeting Room 1,meetingroom1@example.com 

すでに追加されたシステムのリストを同じ形式でエクスポートすることもできます。 
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フィールド 説明 

New System 
Notifications 

既存のルーム メールボックスを Cisco TMSXE に追加する際、カレンダーはすでに将来の予約を含
んでいる場合があります。さらに、Cisco TMSXE は双方向の同期を実行し、Cisco TMS の 

Exchange メールボックスから既存のすべての会議を予約することを試み、Cisco TMS の関連する
システムの既存のすべての予約を Exchange に複製します。 

同期中に競合が発生する場合、または予約が Cisco TMS と一致しない場合は、Exhange の予約が
拒否され、存在する場合は Cisco TMS 予約が優先されます。次のいずれかを選択できます。 

• [Send decline to organizer]：会議主催者は、会議が Cisco TMS によって拒否されたことを
示す通知を受け取ります。 

• [Delete and log]：会議は自動的に拒否されますが、管理者は Cisco TMSXE ログで拒否され
た会議を検索できます。 

同期された会議に関するルーティングの問題またはその他の特定の問題が発生した場合、Cisco 

TMSXE は会議を [Reservation] タイプに「ダウングレード」できます。この場合、自動コール 

セットアップは実行されず、ルーティング リソースは予約されません。 

拒否と同様に、会議主催者に通知するか、または自動的に会議をダウングレードしてログに記録す
ることを選択できます。 

会議のダウングレードに関する詳細については、「Cisco TMSXE からのメッセージ」を参照して
ください。 

Advanced Settings  

Data Files Cisco TMSXE は Cisco TMSXE がインストールされるドライブの次のデフォルトの場所にファイ
ルを保存します（通常は C:）。 

• \ProgramData\Cisco\TMSXE\Storage for data files 
• \ProgramData\Cisco\TMSXE\Config for configuration files 
• \ProgramData\Cisco\TMSXE\Logs for error and event logs 

ProgramData Windows フォルダはデフォルトで非表示になっており、Cisco TMSXE がイン
ストールされるドライブ上にあります。 

Cisco TMSXE クラスタを設定する場合、次の 4 つのフィールドがあります。 

• Shared Data Files 
• Shared Configuration  
• Local Configuration  
• Local Logs 

[Shared Data Files] と [Shared Configuration] は、すべてのノードに読み取りおよび書き込み権限
があるネットワーク共有を指すように変更する必要があります。 

[Local Configuration] は、ローカル サーバでのみ復号化が可能で、ノード間で共有できないユーザ
名とパスワードのデータを含みます。 

Configuration 

Logs 
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フィールド 説明 

[Local Logs] は、ネットワーク共有を指すことができますが、各ノードはログ用に別のフォルダを
持つことが必須です。 

Never Display 
Organizer in Cisco 
TMS Conference Title 

リソース メールボックスが [Delete Subject] と [Add Organizer to Subject] の両方に設定されて
いる場合、この設定を有効にすると、会議の件名が完全に空白になります。 

 

冗長展開の設定 

Cisco TMSXE クラスタリングは Cisco TMSXE サービスのアクティブ/パッシブ冗長性を提供します。Cisco TMS 予約サービス

の冗長性を実現するためには、ネットワーク ロード バランサも導入する必要があります。 

この項では、Cisco TMSXE および Cisco TMS 予約サービスの両方に対して冗長性を設定する手順について説明します。サポー

トされるシナリオと冗長性のしくみの概要については、「冗長導入」（13 ページ）を参照してください。 

制限事項 

• 冗長性は Exchange 2007 ではサポートされません。 

• 冗長性は、Cisco TMSXE が Cisco TMS サーバ上に存在する小規模な展開ではサポートされません。 

• Cisco TMS 予約サービスのロード バランシングは、Cisco TMSXE クラスタリングおよび冗長な Cisco TMS 導入の組み

合わせでのみサポートされます。 

サービス クラスタリングを持つ Cisco TMSXE のインストール 

インストールまたはアップグレード時に、クラスタ サポートを有効にすることで、Cisco TMSXE のアクティブ/パッシブ冗長性

を実装するかどうかを選択できます。 

ご使用になる前に 

両方のサーバが「Cisco TMSXE サーバ ソフトウエア要件」（5 ページ）を満たし、インストール準備ができていることを確認

します。 

次の条件の下で、既存のクラスタ化されていないインストールからクラスタ化されたインストールへアップグレードできます。 

• 最初のノードが Cisco TMSXE 3.x を実行している。 

• インストールの前に、2 番目のノードには Cisco TMSXE のアプリケーションまたはデータ ファイルが存在しない。サ

ーバから Cisco TMSXE を完全に削除する方法については、「Cisco TMSXE 5.0 のアンインストール」（63 ページ）を

参照してください。 
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クラスタ設定向けネットワーク共有の設定 

クラスタリングを伴う Cisco TMSXE をインストールする前に、両方のノードと Cisco TMSXE を設定するユーザに対して読み

取り/書き込み権限があるネットワーク共有を使用可能にする必要があります。 

• この共有と両方のノードはマシン アカウントとの共有が可能な Active Directory ドメインのメンバーである必要があります。 

• アカウントにはフォルダへのファイル共有権限とファイル権限が必要です。 

• ネットワーク共有をノードの一方に配置するか、マップされたドライブ文字を使用することはできません。 

• 両方のノードのマシン アカウントにアクセス可能なネットワーク共有だけを作成し、管理者がインストールを実行するこ

とを推奨します。 

ネットワーク共有にログ フォルダを配置することはできますが、Cisco TMSXE の各ノードが個別の場所にログを保存している

必要があります。ログ レベルは共有設定の一部です。 

セットアップの例 

この Windows Server 2012 のインストール例では、設定はサーバ filestore.example.com に格納され、Cisco TMSXE をインス

トールするノードは tmsxe1.example.com と tmsxe2.example.com です。インストールを行う管理者は tmsxeadmin という名

前のドメイン ユーザです。 

次のように、フォルダを作成し、ファイル共有権限を編集します。 

1. filestore.example.com で、フォルダ tmsxeconfig を作成します。 

2. フォルダ共有を有効にするには、[Properties] > [Sharing] > [Advanced Sharing] に移動します。 

3. [Share this Folder] をチェックします。 

4. [Permissions] をクリックします。 

5. [Add]、[Object Types] の順にクリックし、[Computers] および [Users] にチェックが入っていることを確認します。 

6. オブジェクト名の入力フィールドに、tmsxe1、tmsxe2、および tmsxeadmin を入力します。 

7. [OK] をクリックします。 

8. [tmsxe1] を選択し、[Full Control] を [Allow] に設定します。残りの 2 つのアカウントについて繰り返します。 

9. [OK] をクリックし、再度 [OK] をクリックして、ファイル共有の権限を終了します。 

次のように、権限を編集します。 

1. [Properties] > [Security] で、[Edit] をクリックします。 

2. [Add]、[Object Types] の順にクリックし、[Computers] および [Users] にチェックが入っていることを確認します。 

3. オブジェクト名の入力フィールドに、tmsxe1、tmsxe2、および tmsxeadmin を入力します。 

4. [OK] をクリックします。 

5. [tmsxe1] を選択し、[Full Control] を [Allow] に設定します。残りの 2 つのアカウントについて繰り返します。 

6. [OK] をクリックしてから、[Close] をクリックして、新しい設定を保存します。 
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インストールの実行 

両方のノードで新規インストールおよびアップグレードを行う場合は、インストーラを実行する手順に従い、クラスタリングを

有効にする必要があります。 

 

最初のノードの設定 

構成ツールが起動したら、次の手順を実行します。 

1. 新規インストールの場合、これがクラスタの最初のノードであることを最初に指定します。 
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この設定手順は、既存のインストールをアップグレードする場合は使用できません。

 

2. 「Cisco TMSXE の設定」（34 ページ）に記載されている通常インストールの設定手順に従い、[Systems] タブに少なく

とも 1 つのシステムを追加してください。 

3. [Advanced Settings] タブで、次のように、両方のノードが読み取り/書き込み権限を持つ、共有データおよび設定ファイ

ルのネットワーク共有上の配置先フォルダの場所を変更します。 

\\server\share\Config 

• 新規インストールの場合、これらの場所フィールドは [Shared Data Files] および [Shared Configuration] と呼ば

れます。 

• 非クラスタ化導入からのアップグレードの場合、これらのフィールドは [Data Files] および [Configuration] と呼

ばれます。 

• [Local Configuration] には、ローカル サーバでのみ復号化可能で、共有できないユーザ名とパスワードが含まれます。 

4. [Save] をクリックします。 

2 番目のノードの設定 

構成ツールが起動したら、次の手順を実行します。 

1. 最初のタブで、最初のノードがすでに設定されていることを指定します。 

2. 必要な Exchange 接続の詳細情報を指定します。これは最初のノードとまったく同じにする必要があります。 

Cisco TMSXE はこの詳細情報を使用してプライマリ ノードを特定し、共有可能なすべての設定データがインポートおよ

び検証されます。 
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3. インポートされたデータの概要が表示されます。 

• 一部またはすべてのデータを検証できなかった場合、赤のマークが表示され、問題の対策に関するガイダンスが次

のように示されます。 

1. 最初のノードまたはネットワーク共有へのアクセスに関する問題がある場合はすべて解決します。 

2. このノードでは、前の手順に戻り、インポートを再検証します。 

• 緑のチェックマークが表示されたら、[Next] をクリックします。 

4. Cisco TMS および Exchange の認証詳細情報を入力します。 

これらは、サーバごとに保存する必要があり、インポートできません。 

5. [Next] をクリックして、すべての設定を検証します。 

6. [Next] をクリックして、設定内容を保存します。 

7. [Finish] をクリックします。 

クラスタ セットアップの確認 

リモート デスクトップを使用して、ノードの一方または両方に接続し、次のいずれかを実行します。 

• 構成ツールを起動すると、最初の画面にはクラスタの現在の状態に関する情報が含まれます。 

• どのノードがアクティブになっているかと、接続先のノードの状態に関する情報を含む TMSXE-log.txt を確認します。 

フェールオーバーが機能していることをテストするには、次の手順を実行します。 

1. アクティブ ノードの Cisco TMSXE サービスを停止します。 

2. アクティブに昇格した第 2 ノードで、ログまたは構成ツールを使用して確認します。 

既存のクラスタの設定変更 

Cisco TMS サービスがクラスタ化モードで実行中に、構成ツールからシステムを追加および削除できます。ただし、サービスの

実行中にシステムの交換はできません。 

既存システムの交換などの他の設定変更を行うには、両方のノードで Cisco TMSXE サービスを停止してから構成ツールを起動

し、両方のノードで変更を行った後でサービスを再開します。最初にパッシブ ノードでサービスを停止することを推奨します。 

クレデンシャルの変更 

クラスタ化された導入では Exchange サービス ユーザの変更を避けることを強く推奨します。これは、クラスタ情報が 

Exchange のサービス ユーザに保存されるためです。Cisco TMSXE に新しいサービス ユーザを追加すると、新しいクラスタが

作成されます。 

既存ユーザのパスワードまたは証明書を変更するには、両方のノードに対して常に同時に変更を行う必要があります。 
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Exchange または Cisco TMS クレデンシャルの変更 

1 つのノードでパスワード エラーが発生することを回避するために、変更を行う前に両方のノードを停止することを推奨します: 

1. パッシブ ノードのサービスを停止します。 

2. アクティブ ノードのサービスを停止します。 

3. Active Directory でサービス ユーザのパスワードを変更します。 

4. 最初のノードの構成ツールを使用して、新しいパスワードを追加します。 

5. 第 2 ノードの構成ツールを使用して、新しいパスワードを追加します。 

6. 最初のノードのサービスを開始します。 

7. 第 2 ノードのサービスを開始します。 

クライアント証明書の変更 

同じサービス ユーザを認証する新しい証明書にクライアント証明書を更新するには（一般に、古い証明書の有効期限が切れるた

め）、次の手順を実行します。 

1. パッシブ ノードのサービスを停止します。 

2. 第 2 ノードのサービスを停止します。 

3. このノードの構成ツールを使用して、クライアント証明書を変更します。 

4. 第 2 ノードの構成ツールを使用して、クライアント証明書を変更します。 

5. このノードのサービスを開始します。 

6. 第 2 ノードのサービスを開始します。 

Cisco TMS Booking Service の冗長性の設定 

Cisco TMS Booking Service にネットワーク ロード バランサ（NLB）を使用したアクティブ/アクティブ冗長性を設定すること

により、高可用性を確保できます。 

前提条件 

• プローブ URL が認証されるため、NLB が Windows 認証をサポートする必要があります。 

Cisco TMSXE と組み合わせた動作がテストされ確認されている、F5 BIG-IP バージョン 11.4.1 を使用することを推奨し

ます。 

• Cisco TMSXE サーバは、ネットワーク ロード バランサの仮想 IP を指す DNS エントリが共通名（CN）になっている証

明書を使用する必要があります。 

ご使用になる前に 

• 「サービスのクラスタリングを使用する Cisco TMSXE のインストール」（41 ページ）の説明に従って、両方のノード

に Booking Service を含む同一の Cisco TMSXE を設定します。 
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• Cisco TMS サービスに関して、それぞれの Booking Service ノードのログは独立していますが、ログ レベルは共有設定

の一部であることに注意してください。 

ロード バランサの導入 

1. 両方のノードで 15 秒ごとに次の URL をプローブするように NLB を設定します。/TMSService/Booking.svc/Status/Health 

2. パフォーマンス上の理由から、どちらかのノードにスティッキー接続を行うようにロード バランサを設定する必要があり

ます。 

プライマリ ノードに到達できない場合、ロード バランサはセカンダリ ノードに切り替えます。 

3. NLB の仮想 IP の DNS レコードを作成します。 

4. [Cisco TMSXE Host Address] として次の NLB ホスト名を WebEx に追加します（「WebEx と Cisco TMSXE 間の通信

の設定」（52 ページ）を参照）。 

プローブの応答 

Cisco TMS Booking Service は、Cisco TMS との接続を 15 秒ごとに確認します。 

上記のように各 Booking Service ノードを定期的にプローブすると、次の結果が得られます。 

• AD および Cisco TMS への接続が機能しており、設定ファイルの場所が使用可能である場合は、HTTP 200 OK が返され

ます。 

• 上記の接続のいずれかに問題がある場合は、エラーの詳細を示す 1 つ以上のメッセージとともに HTTP 503 Service 

Unavailable が返されます。 

追加機能の設定 
Cisco TMSXE をインストールして設定すると、会議の場所として TelePresence 対応のルームを追加することにより、ユーザは 

Outlook で TelePresence 会議を予約できるようになります。会議では、Cisco TMS のデフォルト設定が使用されます。 

ユーザが会議ごとに特定の設定を変更したり、自分の会議に WebEx を含めたり、コールインおよびコールアウト参加者をスケ

ジュールしたりできるようにするには、ユーザが追加機能を使用できるようにする必要があります。この章では、使用可能なオ

プションについて説明します。 

WebEx Scheduling Mailbox の設定 

Cisco Collaboration Meeting Rooms Hybrid が使用可能な導入環境では、会議の主催者は WebEx Scheduling Mailbox を使用し

て、TelePresence 会議にデフォルト設定の WebEx 会議を簡単に含めることができます。 
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以下に示すように、管理者が特別なユーザまたはリソース/ルーム メールボックスを作成すると、ユーザはこのメールボックス

を Outlook の会議要求に追加して TelePresence 会議に WebEx を含めることができるようになります。 

次の点に注意してください。 

• このソリューションは、WebEx と TelePresence の両方を使用した CMR Hybrid 会議を作成するために設計されています。 

• TelePresence ルームやコールインの TelePresence 参加者が含まれていなくても、TelePresence インフラストラクチャ

のリソースが予約され会議中に使用されますので、WebEx のみの会議をスケジュールするためにこのメールボックスを

使用しないでください。 

ご使用になる前に 

「Cisco Collaboration Meeting Rooms Hybrid の要件」（8 ページ）に示されているすべての要件が満たされていることを確認

してください。 

メールボックスの作成と設定 

Exchange 管理センター、Exchange 管理コンソール、または Exchange 管理シェルを使用して、メールボックスの作成と設定

を行います。 

1. 「WebEx」という名前の新しいリソース メールボックスを作成します。手順については、以下を参照してください。 

• Office 365 と Exchange 2013：「Create and Manage Room Mailboxes」 

• Exchange 2010：「Create a Room or Equipment Mailbox」 

• Exchange 2007：「How to Create an Equipment Mailbox」 

2. メールボックスの偽装なしで Exchange 2007 または 2010 を使用する場合は、Cisco TMSXE サービス ユーザ アカウン

トにこのメールボックスへのフル メールボックス アクセス権を付与する必要があります。手順については、以下を参照

してください。 

• Exchange 2010：「Allow Mailbox Access」  

• Exchange 2007：「How to Allow Mailbox Access」 

3. メールボックスのプロパティを次のように変更します。 

1. メールボックスの [Calendar Attendant] をオフにします。手順については、以下を参照してください。 

• Office 365 と Exchange 2013：「Set-CalendarProcessing」 

• Exchange 2010：「Configure User and Resource Mailbox Properties」 

• Exchange 2007：「How to Disable the Auto-Processing of Meeting Messages」 

2. メールボックスの [AddNewRequestsTentatively]（または [Mark new meeting requests as Tentative]）を無効

にして、新しい要求が仮要求として自動的にマークされないようにします。 

3. [ForwardRequestsToDelegates] を [False] に設定します。 

4. Office 365、Exchange 2013、および Exchange 2010 の場合は、[CalendarRepairDisabled] を [True] に設定します。 

すでに説明したように、WebEx Scheduling Mailbox をユーザ メールボックスとして作成することを推奨します。Exchange 

2013 以降のユーザ メールボックスは、WebEx Scheduling Mailbox に必要な設定と互換性がありません。 

http://technet.microsoft.com/en-us/library/jj215781(v=exchg.150).aspx�
http://technet.microsoft.com/en-us/library/bb124952(v=exchg.141).aspx�
http://technet.microsoft.com/en-us/library/bb124925(v=exchg.80).aspx�
http://technet.microsoft.com/en-us/library/aa996343.aspx�
http://technet.microsoft.com/en-us/library/aa996343(EXCHG.80).aspx�
http://technet.microsoft.com/en-us/library/dd335046(v=exchg.150).aspx�
http://technet.microsoft.com/en-us/library/bb124255.aspx�
http://technet.microsoft.com/en-us/library/aa998873(v=exchg.80)�
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上記のように設定したユーザ メールボックスは、Exchange 2010 および Exchange 2007 では引き続き機能しますが、

Exchange 2013 および Office 365 では機能しません。 

その他の推奨事項 

さらに、次の設定を推奨します。 

• 必要に応じて、Exchange 管理コンソールの [Mail Flow Settings] または Exchange 管理シェルを使用して、メッセージ

配信制限を強化します。 

たとえば、送信元の認証を義務付けて、特定のグループのユーザからの送信だけを許可します。 

手順については、以下を参照してください。 

• Office 365 と Exchange 2013：「Configure Message Delivery Restrictions for a Mailbox」  

• Exchange 2010：「Configure Message Delivery Restrictions」 

• Exchange 2007：「How to Configure Message Delivery Restrictions」 

• AD ユーザとコンピュータまたは Powershell を使用して、Active Directory ユーザ アカウントを無効に設定します。 

手順については、TechNet の記事「Disable or Enable a User Account」を参照してください。 

Cisco TMSXE へのメールボックスの追加 

インストールまたはアップグレードの直後に、Cisco TMSXE 設定ウィザードにメールボックスを追加できます。 

後の段階でメールボックスを追加する場合は、次の手順を実行します。 

1. 構成ツールを開き、[Exchange Web Services] タブに移動します。 

http://technet.microsoft.com/en-us/library/bb397214(v=exchg.150).aspx�
http://technet.microsoft.com/en-us/library/bb397214.aspx�
http://technet.microsoft.com/en-us/library/bb397214(v=exchg.80).aspx�
http://technet.microsoft.com/en-us/library/cc753390.aspx�
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2. [WebEx Scheduling Email] フィールドに、新たに作成した WebEx Scheduling Mailbox の電子メール アドレスを入力し

ます。 

 

3. [Save] をクリックします。 

Cisco TMSXE を使用した WebEx Productivity Tools with TelePresence の設定 

WebEx Productivity Tools with TelePresence により、次に示す会議を同期的に予約および設定するための特殊なパネルが 

Outlook for Windows に追加されます。 

• WebEx と TelePresence の両方を含む CMR Hybrid 会議。 

• WebEx のみの会議。 

• TelePresence のみの会議。 

このパネルから、WebEx と TelePresence の両方の簡易設定と詳細設定にアクセスできます。これらの設定には、

TelePresence のコールインおよびコールアウト参加者を追加するオプションや、WebEx 参加者が開始時刻よりも前に会議に参

加できるようにするオプションなどが含まれます。 

TelePresence のみの会議を予約する場合でも、すべての主催者は Productivity Tools が機能するように WebEx ユーザを設定す

る必要があることに注意してください。 
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WebEx Productivity Tools with TelePresence の設定と導入の詳細な手順については、『Cisco WebEx Site Administration 

User's Guide』を参照してください。このマニュアルは、WebEx サイトから Web ヘルプまたは PDF ファイルとして入手でき

ます。 

Cisco TMS Booking Service のインストールと設定 

WebEx Productivity Tools with TelePresence が Cisco TMSXE と通信できるようにするには、Booking Service をインストー

ルする必要があります。 

Booking Service のロード バランシングを設定できます。 

• サポートされるシナリオについては、「冗長導入」（13 ページ）を参照してください。 

• 設定手順については、「Cisco TMS Booking Service の冗長性の設定」（46 ページ）を参照してください。 

初期インストール時に Cisco TMS Booking Service を含めていなかった場合は、次の手順に従って Booking Service を導入環境

に追加します。 

1. Cisco TMSXE サーバで [Control Panel] に進みます。 

2. [Programs and Features] を選択します。 

3. [Cisco TMSXE] を右クリックし、[Change] を選択します。 

これによりインストーラが開始され、インストール内容を変更できます。 

4. インストーラで表示されるすべての指示に従い、Cisco TMS Booking Service の追加を選択します。 

インストールが完了すると、IIS のデフォルト Web サイトで TMSService という名前の仮想ディレクトリが使用可能に

なります。 

Booking Service をインストールすると、IIS が強制的に再起動されることに注意してください。Cisco TMS が同じ場所に配置さ

れている場合、Cisco TMS はこの影響を受けます。この配置が推奨されるのは小規模な導入のときだけです。「すべての導入の

ベスト プラクティス」（14 ページ）を参照してください。 

IIS の HTTPS 設定 

Booking Service を動作させるには、Cisco TMSXE と Booking Service の両方がインストールされているサーバ上の IIS で、既

定の Web サイトの HTTPS を有効にする必要があります。冗長導入では、両方のノードでこれを行う必要があります。 

インストール前に IIS がサーバに存在していない場合は、IIS が Booking Service とともに自動的にインストールされます。イン

ストール後、既定の Web サイトに HTTPS を設定する必要があります。 

一般的なガイダンスについては、たとえば IIS の記事「How to Set Up SSL on IIS 7」を参照してください。 

http://www.iis.net/learn/manage/configuring-security/how-to-set-up-ssl-on-iis�
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WebEx Productivity Tools with TelePresence が動作するには、さらに次の手順を実行する必要があります。 

1. IIS マネージャを開きます。 

2. [IIS] > [SSL Settings] に移動します。 

3. [Client certificates] を [Ignore] に設定します。 

WebEx サイトと Cisco TMSXE 間の通信の設定 

1. WebEx サイトで、[Manage Site] > [Site Settings] > [OneTouch TelePresence Options] に移動します。 

2. [Cisco TMSXE Host Address] フィールドで、次のアドレスにサーバのホスト名を入れて、Booking Service の完全なア

ドレスを入力します。https://<hostname>/TMSService/Booking.svc。 

3. 更新内容を保存します。 

Cisco Collaboration Meeting Rooms Hybrid の全体的な設定手順については、『Cisco WebEx Enabled TelePresence 

Configuration Guide』を参照してください。 

Cisco TelePresence 詳細設定フォームの導入 

Cisco TMSXE の提供物には、ビデオ会議を作成または変更するときに Outlook クライアントに機能を追加するカスタム フォー

ムが含まれています。 

使用可能な設定には、会議パラメータの指定や、外部参加者の追加などが含まれます。使用可能な機能の詳細については、

『Cisco TMSXE User Guide (5.0)』を参照してください。 

 

このフォームの導入と使用は任意です。このフォームは、今後いつでもインストール環境に追加できます。 

http://www.cisco.com/en/US/products/ps11338/products_installation_and_configuration_guides_list.html�
http://www.cisco.com/en/US/products/ps11338/products_installation_and_configuration_guides_list.html�
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このフォームは、WebEx なしで TelePresence の詳細設定にアクセスする必要があるユーザが、WebEx Productivity Tools with 

TelePresence の代わりに使用します。 

このフォームは、会議に WebEx を含めるためのオプションを備えていませんが、「WebEx Scheduling Mailbox の設定」

（47 ページ）と組み合わせて使用できます。 

制限事項 

次の点に注意してください。 

• カスタム フォームは Outlook for Windows でのみ動作します。 

• Office 365 では組織フォーム ライブラリはサポートされません。つまり、フォームはローカルでのみパブリッシュでき

ます（下記を参照）。 

• フォームの編集はサポートされません。 

• シスコのフォームを使用して会議が作成された場合は、Outlook のセキュリティにより、会議の招待状をプレビューでき

ません。Outlook の閲覧ウィンドウを使用するときは、招待状を開いて会議の詳細を表示する必要があります。 

ベスト プラクティス 

ベスト プラクティスとして、フォームを組織フォーム ライブラリに配置することを推奨します。これにより、すべてのユーザに

フォームを簡単に配布できるようになり、フォームのその後の更新が自動化されます。Exchange サーバ上の既存の組織フォー

ム ライブラリを使用するか、または新しいライブラリを作成してカスタム フォームをインポートする必要があります。 

組織フォーム ライブラリを使用する導入では、次の 3 つの手順が必要です。 

1. 組織フォーム ライブラリの作成（53 ページ） 

2. Cisco TelePresence フォームのパブリッシュ（54 ページ） 

3. フォームを使用するクライアントの設定（55 ページ） 

Cisco TelePresence フォームをすでに使用していて、これからアップグレードを行う管理者は、ステップ 2 だけを参照する必

要があります。 

組織フォーム ライブラリを使用せずに、Outlook クライアントごとに手動でフォームをロードすることもできます。この場合、

ステップ 1 は省略できますが、フォームを使用するには、事前にフォームをローカルでパブリッシュする必要があります。

「Cisco TelePresence フォームのパブリッシュ」（54 ページ）の手順に従ってください。 

組織フォーム ライブラリの作成 

Exchange 環境には、組織フォーム ライブラリをサポートするために必要なインフラストラクチャがない場合があります。この

ため、Cisco TelePresence フォームをパブリッシュするために必要な手順は、パブリック フォルダがすでに存在するかどうか

によって異なります。 
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組織フォーム ライブラリの設定 

Exchange のパブリック フォルダと組織フォーム ライブラリに関する次の入手可能なマニュアルを参照してください。 

• Exchange 2013：「Create an Organizational Forms Library in Exchange 2013」 

• Exchange 2010：「Create an Organizational Forms Library」 

• Exchange 2007：「How to Create an Organizational Forms Library in Exchange 2007」 

Cisco TelePresence フォームのパブリッシュ 

フォームを使用できるようにするには、事前に Outlook クライアントを使用してフォームをパブリッシュする必要があります。

組織フォーム ライブラリを使用する場合は、次の手順を実行する前にこのライブラリが使用可能な状態になっている必要があり

ます（「組織フォーム ライブラリの作成」（53 ページ）を参照）。 

フォームの取得 

Cisco TMSXE がインストールされたサーバで、次の手順を実行します。 

1. Cisco TMSXE の .zip アーカイブで、VideoConference-*.oft を見つけます。 

2. このファイルを Outlook がインストールされているクライアント コンピュータにコピーします。 

Outlook 2013 または 2010 からのパブリッシュ 

1. Outlook にログインし、予約要求が開いていないことを確認します。組織フォーム ライブラリにパブリッシュする場合は、

フォーム ライブラリの [Owner] 権限を持つユーザとしてログインする必要があります。 

2. リボンで、[File] > [Options] > [Customize Ribbon] に移動します。 

3. [Developer] をオンにして、[OK] をクリックします。 

4. リボンで、[Developer] > [Design a Form...] に移動します。 

5. 開いたダイアログで、[Look In] ドロップダウン メニューを [User templates in File System] に変更します。 

6. [Browse] をクリックします。 

7. コンピュータ上の .oft ファイルを見つけ、それを開きます。 

8. [Publish] ドロップダウン ボタンから [Publish Form As...] を選択します。 

9. 開いたダイアログで、[Look In] ドロップダウン メニューを次のいずれかに変更します。 

• [Organizational Forms Library]：複数のユーザがフォームを使用できるようにする場合。 

• [Personal Forms Library]：現在のユーザ アカウントだけが使用できるようにフォームをパブリッシュする場合。 

10. 次に示すとおりに、2 つのフィールドに名前を入力します（大文字と小文字を区別します）。 

• [Display Name]：Meeting 

• [Form name]：VideoConference 

11. 完了したら、[Publish] をクリックします。 

フォームがパブリッシュされ、予定フォームとしてユーザが選択できるようになります（「フォームを使用するクライアントの

設定」（55 ページ）を参照）。 

http://www.slipstick.com/exchange/exchange-2013/create-organizational-forms-library-exchange-2013/�
http://technet.microsoft.com/en-us/library/gg236889(v=exchg.141).aspx�
http://technet.microsoft.com/en-us/library/cc540468(EXCHG.80).aspx�
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Outlook 2007 からのパブリッシュ 

1. Outlook にログインし、予約要求が開いていないことを確認します。組織フォーム ライブラリにパブリッシュする場合は、

フォーム ライブラリの [Owner] 権限を持つユーザとしてログインする必要があります。 

2. メニューで、[Tools] > [Forms...] > [Design a Form...] に移動します。 

3. [Look In] ドロップダウン メニューを [User templates in File System] に変更します。 

4. [Browse] をクリックします。 

5. コンピュータ上の .oft ファイルを見つけ、それを開きます。 

6. [Publish] ドロップダウン ボタンから [Publish Form As...] を選択します。 

7. 開いたダイアログで、[Look In] ドロップダウン メニューを次のいずれかに変更します。 

• [Organizational Forms Library]：複数のユーザがフォームを使用できるようにする場合。 

• [Personal Forms Library]：現在のユーザ アカウントだけが使用できるようにフォームをパブリッシュする場合。 

8. 次に示すように、2 つのフィールドに名前を入力します。 

• [Display Name]：Meeting 

• [Form name]：VideoConference 

9. 完了したら、[Publish] をクリックします。 

フォームがパブリッシュされ、予定フォームとしてユーザが選択できるようになります（「フォームを使用するクライアントの

設定」（55 ページ）を参照）。 

フォームを使用するクライアントの設定 

フォームをパブリッシュすると、ユーザはそのフォームを使用できるようになりますが、Outlook クライアントでそのフォーム

の使用が強制されるわけではありません。そのフォームを使用する Outlook の設定は、各ユーザによって、または Microsoft 

Windows レジストリの変更によって行われる 1 回限りのクライアント設定です。レジストリの変更は、グループ ポリシーなど

の方法を使用して自動的に実行できます。 

Microsoft の記事「How to globally change the default forms in Outlook by using the Forms Administrator utility」には、デ

フォルト フォームを変更するレジストリ キーを作成するためのユーティリティに関する説明とそのユーティリティへのリンク

が記載されています。 

フォームを使用するクライアントの手動設定 

コンピュータごとにフォームを設定するには、各ユーザが次の手順を実行する必要があります。 

1. Outlook クライアントを開き、予定表に移動します。 

2. 左側のフォルダ ビューで [Calendar] エントリを右クリックして、[Properties] を選択します。 

3. Outlook 2010 のみ：[Folder] タブをクリックし、[Calendar Properties] をクリックします。 

4. [General] タブが選択された状態で [Calendar Properties] ウィンドウが開きます。 

5. [When posting to this folder, use] ドロップダウン リストから、[Forms] を選択します。 

http://support.microsoft.com/kb/241235/EN-US/�
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6. ダイアログが開きます。[Look In] ドロップダウン メニューで、フォームがパブリッシュされたライブラリ

（[Organizational Forms Library] または [Personal Forms Library]）を選択します。 

 

7. 「Meeting」という名前のエントリが表示されます。それを選択して [Open] をクリックします。 

8. [Calendar Properties] ページに戻ります。[OK] をクリックして、変更を保存します。 

これで、クライアントのすべての予定表操作で Cisco TelePresence フォームが使用されるようになり、新しい予約要求を作成

するときに [Cisco TelePresence] タブが表示されるようになります。 

Cisco TMSXE の管理 

Cisco TMSXE サービスの起動と停止 

Cisco TMSXE は、Windows Server の [Services] スナップインから開始および停止できるサービスです。 

Cisco TMSXE 構成ツールは、エンドポイントの追加と削除以外の設定変更を行う必要があるときにサービスを自動的に停止し、

ユーザがツールを閉じるときにサービスを再起動するプロンプトが表示されます。これらのプロンプトで実行しなかった場合は、

手動でサービスを起動および停止する必要があります。 

クラスタ導入では、すべての設定を有効にするために両方のノードでサービスを停止し、設定変更の完了後に両方のサービスを

再起動する必要があります。 
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サービスを起動できるようにするには、その前に構成ツールを閉じて初期設定を完了する必要があります。 

1. Server Manager を開きます。 

2. [Configuration] > [Services] > [Cisco TMSXE] に移動します。 

3. [Cisco TMSXE] を右クリックして、[Start] または [Stop] を選択します。 

サービスが起動しなかった場合は、エラーが記録されます。詳細については、「トラブルシューティング」（64 ページ）を参照

してください。 

サービスの停止中に予約要求または変更要求が行われた場合、それらの要求はキューに登録され、サービスが再起動した直後に

処理されます。 

構成ツールの起動 

このツールを起動するには、次のいずれかを実行します。 

• Windows Server の [Start] メニューまたはスタート画面で、[Start] > [All Programs] > [Cisco] > [Cisco TMSXE 

Configuration] に移動します。 

• コマンド プロンプトから管理者としてツールを実行します。構成ツールは、Cisco TMSXE インストール フォルダにあり

ます。デフォルトのプログラム パスは C:\Program Files\Cisco\TMSXE\ConfigurationApp.exe です。 

ツールの起動時に、Cisco TMSXE サービスを停止するかどうかを尋ねられます。新しいシステムを追加する場合、または既存の

システムを削除する場合は、サービスを実行したままにできます。すべての設定オプションを使用可能にするには、サービスを

停止する必要があります。 
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ツールの起動時に Cisco TMSXE サービスを停止した場合は、終了時にサービスを再起動するように求められるプロンプトが表

示されます。 

スイッチ 

このツールは、次のスイッチをサポートします。 

• -help は、短いヘルプ ファイルを表示します。 

• -wizard は、初期セットアップ時に必要なすべてのフィールドを設定するためのセットアップ ウィザード モードで構成

ツールを実行します。設定が検出されなかった場合は、既存の展開環境から設定を移行するかどうかをユーザに尋ねるプ

ロンプトが表示されます。 

通常の管理タスクの場合は、コマンドライン引数なしで構成ツールを実行します。 

エンドポイントの追加、削除、および置換 

ここでは、Cisco TMSXE の稼動中に導入環境内のエンドポイントおよびメールボックスを追加、削除、および置換する方法につ

いて説明します。 

Cisco TMSXE サービスを停止せずにシステムを追加および削除できますが、エンドポイントまたはメールボックスを置換する場

合や、以前に削除されたものを再度追加する場合は、サービスを停止し、構成ツールでフル設定モードを有効にする必要がある

ことに注意してください。 

エンドポイントの追加 

すでに予約が含まれている既存のメールボックスを Cisco TMSXE 導入環境に追加する場合は、最初の複製中に Cisco TMS のパ

フォーマンスに影響が出ることが予想されるため、営業時間外に行う必要があります。 

1 つ以上のエンドポイントを導入環境に追加するには、次の手順に従います。この手順は、Cisco TMSXE がクラスタ化されてい

るかどうかに関係なく同じであることに注意してください。 

1. エンドポイントが Cisco TMS にすでに追加されていること、およびシステム単位のオプション キーを使用する場合は 

Cisco TMSXE のシステム ライセンスが十分に用意されていることを確認します。 

2. 「Exchange での Cisco TMS エンドポイント用のメールボックスの作成」（25 ページ）の手順に従って、エンドポイン

トのルーム メールボックスを作成または再使用します。 

3. 「ルーム メールボックスの設定」（26 ページ）の手順に従って、メールボックスが正しく設定されていることを確認し

ます。 

4. [Start] > [All Programs] > [Cisco] > [Cisco TMSXE Configuration] に移動して、構成ツールを起動します。 

5. [Add or remove systems while Cisco TMSXE is running] を選択し、[Next] をクリックします。 
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6. エンドポイントを追加するには、次の 2 つの方法があります。 

• 各エンドポイントを手動で追加します。 

1. ルーム メールボックスの名前を生成するための電子メール アドレス パターンを変更します。ルーム メー

ルボックスのプライマリ SMTP アドレスを使用します（エイリアスはサポートされていません）。次の 2 

つのオプション変数を使用できます。 

• {{TmsId}} は、Cisco TMS から追加するシステムの数値のシステム ID に変換されます。 

• {{DisplayName}} は、Cisco TMS でのシステムの表示名に変換されます。表示名に含まれるス

ペースは自動的に削除されることに注意してください。 

2. 左側のリストからエンドポイントを選択し、[>>] をクリックして Cisco TMSXE にエンドポイントを追加

します。複数のエンドポイントを選択するには、Ctrl または Shift キーを使用します。 

3. 必要に応じて個々の電子メール アドレスを変更するには、右側のリストに追加した後にそれらをダブルク

リックします。 

• 電子メール アドレスと Cisco TMS でのシステム ID を含むエンドポイントのカンマ区切りリストをインポートす

るには、[Import Systems from CSV file] をクリックします。 

このリストは .csv ファイルとして保存されている必要があり、有効な形式は次のとおりです（ヘッダー行と 

[System Name] フィールドはオプションであり、2 行目には値の例が含まれています）。 

TMS ID, System Name,Email 42,Meeting Room 1,meetingroom1@example.com 

7. [Save] をクリックします。 

追加されたメールボックスが検証されます。多くのシステムを追加した場合、これには時間がかかることに注意してくだ

さい。エンドポイントが 250 個の場合は、このプロセスに約 90 秒かかる可能性があります。 

8. [Exit] をクリックします。 

変更が適用されるまでに、最低でも 10 分かかります。場合によっては、最大で 30 分かかります。 

エンドポイントの削除 

この手順は、クラスタ環境と非クラスタ環境で同じであることに注意してください。 

1. [Start] > [All Programs] > [Cisco] > [Cisco TMSXE Configuration] に移動して、構成ツールを起動します。 

2. [Add or remove systems while Cisco TMSXE is running] を選択し、[Next] をクリックします。 

3. Cisco TMSXE に追加されたシステムのリストで、対象のシステムを見つけます。複数のシステムを選択するには、

Shift または Ctrl キーを使用します。[<<] をクリックします。 

4. 終了したら、[Save] をクリックして残りのシステムを検証します。 

5. [Exit] をクリックして構成ツールを閉じます。 

変更が適用されるまでに、最低でも 10 分かかります。場合によっては、最大で 30 分かかります。 

上記の手順によってエンドポイントとそのメールボックスが Cisco TMSXE から削除されますが、それとは無関係に Cisco TMS 

と Exchange では、そのメールボックスとシステムが予約可能な状態のままになっています。 
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Exchange 統合オプション ライセンス フラグの無効化 

Exchange 統合オプション キーを使用する場合は、削除されたエンドポイントによってライセンスが使用されないように、

Cisco TMS の設定も無効にする必要があります。 

次のようにシステムを更新します。 

1. Cisco TMS で、[Systems] > [Navigator] に移動します。 

2. 目的のシステムを選択します。 

3. [Settings] タブをクリックします。 

4. [TMS Scheduling Settings] ペインに、[Allow Remote Bookings] があります。 

設定が [Yes] の場合、システムは現在 Exchange 統合オプション ライセンスを使用しています。 

5. この設定を無効にするには、次の手順を実行します。 

1. [Edit Settings] をクリックします。 

2. [Allow Remote Bookings] をオフにします。 

3. [Save] をクリックします。 

導入環境からのエンドポイントの削除 

導入環境からエンドポイントを完全に削除するには、さらに次の手順を実行する必要があります。 

• Exchange からメールボックスを削除します。 

• Cisco TMS からシステムを削除します。 

エンドポイントの置換 

次の操作を行う必要がある場合は、Cisco TMSXE サービスを停止し、構成ツールでフル設定モードを有効にする必要があります。 

• Cisco TMSXE の既存のエンドポイントを新しいメールボックスに関連付ける。 

• Cisco TMSXE の既存のメールボックスを別のエンドポイントに関連付ける。 

• メンテナンスなどの目的で以前に削除されたエンドポイントを再度追加する。 

クラスタ展開では、次の手順に従います。 

• 設定変更を行う前に、両方のノードで（パッシブ ノードから先に）サービスを停止します。 

• 両方のサービスを再起動する前に、すべての変更を完了します。 
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Cisco TMSXE からのメッセージ 

主催者は、Outlook を使用してビデオ会議を予約したときに、Exchange と Cisco TMSXE の両方からメッセージを受信します。 

次の場合は、Cisco TMSXE からメッセージが送信されます。 

• 会議のルーティングが次のいずれかの設定値で正常に設定された場合。 
• Automatic Connect 
• Manual Connect 
• No Connect 
• One Button to Push 

• 要求された会議ルーティングが失敗し、会議が代わりに [Reservation] として予約された場合（下記を参照）。 

• 会議が [Reservation] 設定で正常に予約されたものの、1 つ以上のリソースが利用できなかった場合。 

次の場合は、Cisco TMSXE から通知が送信されません。 

• [Reservation] 設定で正常に予約された会議のすべてのリソースが使用可能な場合。 

• 主催者によって会議が削除された場合。 

Cisco TMSXE は Cisco TMS で行われた予約または更新に関する通知を送信しないことにも注意してください。システムの設定
によっては、Cisco TMS から通知が送信されます。 

Cisco TMS で問題のある予約や失敗した予約を特定して修正する方法については、「問題のある会議、ダウングレードされた会
議、および拒否された会議の特定と修正」（69 ページ）を参照してください。 

電子メールの通知 

主催者に通知するために使用されるテンプレートは、Cisco TMS にあります。ただし、Cisco TMS から送信される電子メール 

メッセージに、Cisco TMSXE がエラー、警告、および情報テキストを挿入することがあります。 

管理者はこれらのメッセージを変更できます。 

テンプレートの変更 

中括弧内のテキストは、他のメッセージを埋め込むための変数なので、削除または変更しないでください。 

すべてのテンプレートは、最初のサービス起動時に Cisco TMSXE の設定フォルダ（デフォルトでは 

C:\ProgramData\Cisco\TMSXE\Config）に作成されます。すべてのテンプレート名は先頭の template_ とそれに続く記述名で
構成されます。HTML 電子メール用のテンプレートについては、拡張子ではなくファイル名に HTML が含まれています。 

テンプレートを変更するには、次の手順を実行します。 

1. マークアップやヘッダーを自動的に変更しないテキスト エディタまたは HTML エディタで、テンプレート ファイルを開
きます。 

2. 内容と書式のいずれかまたは両方を必要に応じて編集します。 

3. .sample 拡張子を付けずに、変更したファイルを保存します。 

4. 変更したテンプレートを適用するため、Cisco TMSXE サービスを再起動します。 
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サービスが起動するたびに、すべての .sample ファイルが上書きされるかデフォルトに戻され、欠落しているテンプレート ファ
イルが再生成されます。 

Cisco TMSXE のバックアップ、移行、およびアンインストール 

Cisco TMSXE のバックアップ 

Exchange、Cisco TMS、および Active Directory のパスワードのストレージは、Microsoft CryptoAPI を使用して暗号化されま

す。パスワードは、Cisco TMSXE のパスワード エントロピーと LocalMachine に設定された暗号化データ保護スコープの組み

合わせを使って暗号化されます。したがって、パスワードを復号化できるのは、Cisco TMSXE をホストしているサーバで実行さ

れているプロセスだけです。 

これは、暗号化されたパスワードを設定内に保持するには、Cisco TMSXE の完全バックアップにサーバの OS 全体を含める必要

があることも意味します。 

ただし、復元後の再インストール時にオプションでパスワードを再入力できる場合は、バックアップに含める必要があるのは設

定、ストレージ、およびログ フォルダの内容だけです。これらのファイルは、再インストールの前に新しいターゲットにコピー

する必要があります。 

新しいサーバへのアプリケーションの移行 

サーバを使用停止にする場合でも、導入環境を拡張するために追加のハードウェア機能が必要な場合でも、Cisco TMSXE の設定、

監視対象システムのリスト、および複製状態を新しいサーバに引き継ぐには、次の手順に従ってください。 

ご使用になる前に 

両方のサーバで同じバージョンの Cisco TMSXE が使用されている必要があります。また、移行中に設定を変更しないでください。 

• アップグレードも必要な場合は、アプリケーションの移行プロセスを開始する前に、元のサーバでアップグレードを実行

してください。 

• 設定変更を計画する場合は、移行が完了し、サービスが正常に動作していることを確認してから、新しいサーバ上で設定

変更を実行してください。 

• サーバがクラスタ導入の一部である場合は、アプリケーションを移行する前に、クラスタの設定ファイルとデータ ファ

イルを保持するネットワーク共有へのアクセス権を新しいサーバまたはノードに付与してください。詳細については、

「サービスのクラスタリングを使用する Cisco TMSXE のインストール」（41 ページ）を参照してください。 

アプリケーションの移行 

1. Cisco TMSXE を新しいサーバにインストールします。手順については、「新規インストールの実行」（32 ページ）を参

照してください。 

2. 構成ツールを起動するように求められたら、[Yes] をクリックします。 

3. 構成ツールを起動すると、必要なプログラム データ フォルダ構造が作成されます。 
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4. 構成ツールを閉じます。 

5. 元のサーバの Cisco TMSXE Windows サービスを停止します。 

6. 元のサーバから次のフォルダをコピーします。 
• /config 
• /storage 
• /logs 

これらのデフォルトの場所は、C:\ProgramData\Cisco\TMSXE\ です。これらが独自の場所に移動されている場合は、元

のサーバの構成ツールの [Locations] タブで場所を確認できます。 

7. 元のサーバでの場所に関係なく、これらのフォルダを新しいサーバのデフォルトの場所に配置し、既存のフォルダとファ

イルを上書きすることに同意します。 

8. 構成ツールを実行します。 

9. パスワード フィールドが破損したことを示す通知を受信したら、[OK] をクリックします。 

10. [Cisco TMS] タブで、次の手順を実行します。 

1. 必要に応じて [Hostname] フィールドを更新します。 

たとえば、Cisco TMS と共有するサーバから Cisco TMSXE を移行する場合は、ホスト名を「localhost」にする

ことはできません。 

2. パスワードを入力します。 

3. [Save] をクリックしないでください。Exchange Web Services のパスワードが入力されるまで、この操作は失敗します。 

11. [Exchange Web Services] タブに移動し、次の手順を実行します。 

1. パスワードを入力します。 

2. [Save] をクリックします。 

12. オプションで、設定ファイルを独自の場所に保存する場合は、次の手順を実行します。 

1. [Advanced Settings] タブに移動します。 

2. 必要に応じてファイル パスを変更します。 

3. [Save] をクリックします。 

13. 構成ツールを閉じます。 

14. Cisco TMSXE サービスを起動します。 

アプリケーションを移行したら 

移行後は、元のサーバで Cisco TMSXE に関連するサービスを再度アクティブにしないでください。 

サーバ自体を使用停止にしない場合は、元のサーバから Cisco TMSXE を削除することを強くお勧めします（「Cisco TMSXE 

5.0 のアンインストール」（63 ページ）を参照）。 

Cisco TMSXE 5.0 のアンインストール 

1. Cisco TMSXE サーバに管理者としてログインします。 

2. [Control Panel] > [Programs and Features] に移動します。 

3. [Cisco TMSXE] を右クリックし、[Uninstall] を選択します。 
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サーバからの Cisco TMSXE の削除 

ソフトウェアをアンインストールした後で、次の手順を実行します。 

1. すべてのデータ ディレクトリ（デフォルトでは次のとおり）を削除します。 
• C:\ProgramData\Cisco\TMSXE\Storage 
• C:\ProgramData\Cisco\TMSXE\Config 
• C:\ProgramData\Cisco\TMSXE\Logs 

2. レジストリ エントリ HKEY_LOCAL_MACHINE\SOFTWARE\Cisco\TMSXE を削除します。 

トラブルシューティング 
ここでは、Cisco TMSXE のインストール、設定、および操作中に発生する可能性がある問題のトラブルシューティングについて

説明します。また、ロギング機能の使用方法についても説明します。 

Windows イベント ログの読み取り 

1. [Start] メニュー、スタート画面、デスクトップ、またはエクスプローラで [Computer] を右クリックし、[Manage] を選

択します。 

2. [Server Manager] > [Diagnostics] > [Event Viewer] > [Applications and Services Logs] > [Cisco TMSXE] に移動します。 

3. F5 キーを押してログ ペインを更新します。ログ ペインには、起動、エラー、およびログの場所に関する情報が一覧表示

されます。 

ロギングのしくみ 

Cisco TMSXE は、トラブルシューティングに役立ついくつかのログを作成します。これらのログのデフォルトの場所は 

C:\ProgramData\Cisco\TMSXE\Logs です。 

この場所は、インストール時またはインストール後に構成ツールを使用して再設定できます（「設定リファレンス」（37 ページ）

を参照）。 

• TMSXE-log-file.txt は、Cisco TMSXE Windows サービスのすべてのアクティビティを記録します。 

• TMSXE-conference-history-log-file.txt は上記のフィルタされたビューで、すべての会議イベントを記録します。 

• TMSXE-decline-downgrade-log-file_YYYYMMDD.txt は上記のフィルタされたビューで、拒否またはダウングレードさ

れたすべての会議を記録します。「拒否およびダウングレードされた会議のフィルタされたログ」（65 ページ）を参照

してください。 

• TMSXEConfig-log-file.txt は、構成ツールのアクティビティを記録します。 

• TMSXEService-log-file.txt は、同期予約プロキシである Cisco TMS Booking Service のアクティビティを記録します。

このファイルは、Booking Service がインストールされ、アクセスされた場合にのみ生成されます。 
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• TMSXEMeetingAnalyzerApplication-log-file.txt は、Meeting Analyzer のアクティビティを記録します。会議分析の結

果は、ツール自体の内部から取得したレポートに表示されることに注意してください。このログには、ツールの操作中に

発生した接続の問題やその他のエラーが含まれます。 

すべてのログ ファイルのサイズは 5 MB までに制限されています。この制限に達した場合は、次のようになります。 

•  同じ名前の新しいファイルが作成されます。 

• 古いログ ファイルは、サフィックス .1 が付いた名前に変更されます。 

• .1 ファイルがすでに存在する場合、そのファイルは .2 に名前が変更され、以降同様に続きます。 

• 保存されるログ ファイルの最大数は 15 です。ログ ファイルのサフィックスが .15 に達すると、現在のログ ファイルが 

5 MB になったときに、そのファイルが削除されます。 

拒否された会議およびダウングレードされた会議のフィルタされたログ 

ログ ファイル TMSXE-decline-downgrade-log-file_YYYYMMDD.txt は、Cisco TMSXE Windows サービスによって毎日作成

されます。このログには、TMSXE-log-file.txt に記録された次の予約に関するすべてのエントリが含まれます。 

• Cisco TMS によって拒否された会議 

• Cisco TMSXE によってダウングレードされ、その後 Cisco TMS で [Reservation] として予約された会議 

最大 20 個のログがサーバに保存されます。20 個のログが蓄積されたときは、最初のログが上書きされます。ログを長期間保持

する必要がある場合は、これらのログのバックアップ手順を独自に作成してください。 

拒否およびダウングレードに関するログ メッセージの例を次に示します。 

• 要求された予約が失敗した場合：Saving routed conference failed, will try to downgrade to reservation only 

• 予約（ダウングレード）が成功した場合：Conference successfully downgraded to Reservation Only 

• 予約が失敗した場合：Failed to reserve all systems for conference 

• 予約が拒否された場合：Conference with single TMS participant declined 

デバッグ ロギングの有効化 

デフォルトのログ レベルは情報です。デバッグを行う場合は、次の手順に従ってログ レベルを変更します。 

1. メモ帳または別のテキスト エディタを管理者として開きます。 

2. コンピュータ上の Cisco TMSXE Config フォルダを見つけます。デフォルトでは、C:\ProgramData\Cisco\TMSXE\Config 

にあります。ProgramData Windows フォルダはデフォルトで非表示になっていることに注意してください。 

3. ドロップダウンを変更して、すべてのファイルを検索します。 

4. Log4net.config ファイルを開きます。 

5. <level value ="INFO" /> という行の「INFO」を「DEBUG」に置き換えます。 

6. ファイルを保存して、閉じます。 
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この設定を行うと、各ログのサイズが大幅に増加します。デバッグが終わったら、ログ レベルを「INFO」に戻すことを強く推奨

します。戻す手順は上記と同じです。 

TMSXE-conference-history-log は INFO レベルしかないため、DEBUG に変更しても影響を受けません。 

クラスタ導入でのロギング 

ログの場所がネットワーク ドライブに配置される場合もありますが、この場所は共有できません。各ノードは固有のログを保持

する必要があります。 

Log4net.config ファイルは共有設定の一部です。つまり、デバッグ ロギングの有効化と無効化は両方のノードに自動的に反映さ

れます。 

インストールの失敗 

Booking Service とともに Cisco TMSXE をインストールすると、次の場合にインストールが失敗します。 

• IIS のデフォルト サイトが手動で削除されている場合。 

この問題を解決するには、IIS のサイトを手動で作成して、インストールを再試行する必要があります。 

• IIS で HTTPS バインディングだけを使用してサイトが設定されている場合。 

この問題を解決するには、HTTP バインディングを追加してインストールを再試行する必要があります。 

設定中のエラー 

Cisco TMSXE の設定プロセスで構成ツールの使用中に発生するエラー メッセージは、一般に他のシステムへの接続に関する問

題を示しています。トラブルシューティング手順では、最初に必ずユーザ名とパスワードを含む接続のすべての詳細情報が正し

いことを確認する必要があります。 

信頼できない証明書 

デフォルトでは、Cisco TMSXE は Cisco TMS および Exchange Web Services とのセキュア通信に HTTPS を使用します。 

初期設定中にこれらのサーバのいずれかまたは両方に信頼できない証明書が存在することが構成ツールによって検出された場合

は、このことを通知するプロンプトが表示されます。 

このプロンプトには、信頼できない証明書を許可するためのオプション（[Allow Untrusted Certificates]）も表示されます。た

だし、この設定は安全性が考慮されておらず、元に戻すことができないため、テスト環境でのみ使用してください。 

Cisco TMSXE のセキュリティ モデルと信頼できる証明書の定義の詳細については、「Cisco TelePresence Management Suite 

Extension for Microsoft Exchange Administrator Guide (3.0)」を参照してください。 
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リモート名を解決できなかった 

Cisco TMS サーバのアドレスを入力するときにプロトコル（HTTP または HTTPS）を含めると、次のエラー メッセージが表示

されます。 

「Cannot connect to Cisco TMS using the details provided.Verify that all fields are filled in correctly and save again.Error is: 

The remote name could not be resolved: 'http'.」 

サーバ アドレスからプロトコルを削除して IP アドレスまたは FQDN だけを残し、[Next] を再度クリックして設定を検証し、

セットアップを続行してください。 

Cisco TMS サービス ユーザ アカウントが「代理予約」権限を持つグループに属していない 

• Cisco TMS の権限はグループ レベルで制御されます。サービス ユーザのアカウント設定が「代理予約」権限を持つグ

ループに属していることを確認する必要があります。「Cisco TMSXE 用の Cisco TMS ユーザの作成」（23 ページ）

を参照してください。 

• このエラーは、IIS の Cisco TMS サーバに対する認証設定が正しくない場合にも表示されます。 

Mailbox Database is Temporarily Unavailable 

設定中に Exchange Web Services の設定を検証したときに上記のエラー メッセージが表示された場合は、Cisco TMSXE が 

Exchange への接続に失敗しています。 

Exchange Information Store を再起動してから、検証手順を再試行する必要がある場合があります。詳細については、Microsoft 

サポート技術情報の記事「Services for Exchange Server 2007 or Exchange Server 2010 cannot start automatically after you 

install Exchange Server 2007 and Exchange Server 2010 on a global catalog server」を参照してください。 

The Client Access Server Version Does Not Match ... 

Exchange 接続の詳細情報を送信したときに「The Client Access Server version does not match the accessed resource's 

Mailbox Server version」というエラー メッセージが表示された場合は、Exchange 2010 を使用するように導入環境を変更した

のに、Exchange サーバのアドレスを 2010 CAS サーバのアドレスに更新し忘れている可能性があります。 

サーバ アドレスを更新して検証を再試行してください。 

A Time Zone with the Specified ID Could Not Be Found 

Exchange 設定の検証中に Exchange CAS サーバに接続できなかったことを示すエラー メッセージが表示され、サーバからの

メッセージが「A timezone with the specified ID could not be found」である場合、このエラー メッセージは Exchange CAS 

サーバ上のタイムゾーンの設定エラーまたは Windows 更新プログラムの未適用を示しています。 

常にタイムゾーンの最新の累積更新プログラムをインストールすることを推奨します（互換性の最小要件は 2010 年 12 月の累

積更新プログラムです）。 

http://support.microsoft.com/kb/940845�
http://support.microsoft.com/kb/940845�
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詳細とダウンロード リンクについては、Windows に関するサポート技術情報の記事「December 2010 cumulative time zone 

update for Windows operating systems」を参照してください。 

予約できない、またはライセンス供与されていないシステム 

Cisco TMSXE のライセンスが供与されていないシステム、または別の理由で予約できないシステムを Cisco TMSXE に 1 つ以上

追加すると、構成ツールにエラー メッセージが表示されます。 

ライセンス 

設定を完了して Cisco TMSXE を起動するには、次のいずれかを行う必要があります。 

• 「Cisco TMS の要件」（7 ページ）に従って、Cisco TMSXE に追加されたすべてのシステムに Outlook 予約のライセン

スが供与されていることを確認します。 

• ライセンス要件（「Cisco TelePresence Management Suite Extension for Microsoft Exchange Installation Guide」を

参照）に従って、Cisco TMSXE に追加されたすべてのシステムに Outlook 予約のライセンスが供与されていることを確

認します。 

• ライセンス供与されていないシステムを削除します。 

予約できない 

他の理由でエンドポイントが予約できない場合もあります。たとえば、管理者がエンドポイントのメンテナンスを行うために 

Cisco TMS で [Allow Bookings] を無効にした可能性があります。 

予約できないエンドポイントを Cisco TMSXE に追加しようとした場合は、影響を受けるエンドポイントのシステム ID がエラー

メッセージに含められます。 

設定を完了して Cisco TMSXE を起動するには、次のいずれかを行う必要があります。 

• 影響を受けるすべてのシステムを予約可能にします。 

• エラーが発生したすべてのシステムを Cisco TMSXE から削除し、システムが予約可能になったら再度追加します。 

Cisco TMSXE サービスが起動しない 

サービスが「起動して停止した（started and then stopped）」ことを示すエラー メッセージが表示された場合は、構成ツール

が開いている可能性があります。構成ツールを閉じて、サービスを再実行してください。 

これに該当しない場合は、「Shutting down..」メッセージの前に表示されるエラーのイベント ログを調べてください。

「Windows イベント ログの読み取り」（64 ページ）を参照してください。 

サービスが起動しない理由として、他に次のようなものが考えられます。 

• サービスが Exchange Web Services または Cisco TMS に接続できなかった。 

• サービスにログフォルダへの書き込み権限がない。 

http://support.microsoft.com/kb/2443685�
http://support.microsoft.com/kb/2443685�
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• Cisco TMSXE フォルダ内のファイルが使用中である。 

• 設定が不完全である。構成ツールを起動し、すべてのフィールドを確認して入力し、ツールを閉じてサービスを再実行し

てください。 

• Cisco TMS で 1 つ以上のシステムを予約できない。「予約できない、またはライセンス供与されていないシステム」

（68 ページ）を参照してください。 

予約が承認または拒否されない 

予約しようとする 1 つ以上のエンドポイントから承認/拒否メッセージが受信されない場合は、ルーム メールボックスの自動承

認が有効になっていない可能性があります。使用しているバージョンの Exchange でこのオプションを設定する方法の詳細につ

いては、「Exchange での Cisco TMS エンドポイント用のメールボックスの作成」（25 ページ）を参照してください。 

現行の要件である Service Pack 3 よりも前のバージョンの Exchange 2010 を実行している可能性があります。Exchange 2010 

SP2 までの自動承認機能では、スクリプトを使用するフォーム（Cisco TelePresence フォームなど）はサポートされませんで

した。そのようなフォームを持つクライアントからの予約は、ルーム メールボックスで保留中のままになります。この問題を解

決するには、Microsoft Exchange SP3 にアップグレードしてください。 

予約が複製されない  

Exchange との間で予約が複製されない場合は、次の作業を実行します。 

• イベント ログで、Exchange または Cisco TMS との接続に問題がないかどうかを調べます。（「Windows イベント ロ

グの読み取り」（64 ページ）を参照してください。） 

• TMSXE サービスが実行されていることを確認します。 

また、Cisco TMSXE で更新できるのはルームの予定表だけであり、主催者の予定表は更新できないことに注意してください。し

たがって、Cisco TMS で行った予約の変更は、ルームの予定表には表示されますが、主催者の予定表には表示されません。 

問題のある会議、ダウングレードされた会議、および拒否された会議の特定と修正 

Cisco TMS での予約時に問題が発生すると、次の表に要約されているように、会議は問題のある会議として保存されるか、

[Reservation] タイプ（ルーティングなし）にダウングレードされるか、または拒否されます。 

表 6 予約の問題、原因、および解決策 

根本原因 結果 解決策 

会議が Cisco TMS の予約の範囲外にあ

るか、サポートされない定期的なパター

ンを使用するか、または既存の会議と重

複している。 

Cisco TMS によって拒

否される 

主催者または管理者は、有効な詳細情報を使用して再度

予約する必要があります。管理者は、Exchange のすべ

てのリソース メールボックスの予約枠を Cisco TMS の

全体的な予約枠に合わせる必要があります。管理者は、

Exchange で TelePresence ルームの二重予約を禁止す

る必要があります。 
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根本原因 結果 解決策 

Cisco TMS での予約時にリソース競合が

発生する。 

Cisco TMS によって問

題のある会議として保

存される 

主催者または管理者は、リソースが競合しないように予

約を更新するか、Outlook または Cisco TMS からリソ

ースを解放して予約を再度保存する必要があります。 

設定に問題（ソフトウェア ライセンス

や予約権限の欠落など）があるか、エ

ンドポイントでのスケジューリングが

無効になっているため、1 人以上の参

加者（TelePresence ルーム）を会議

にスケジュールできない。 

Cisco TMSXE によって

一時的にダウングレー

ドされ、失敗した場合

は Cisco TMS によっ

て拒否される。 

管理者は、設定またはライセンスの問題を解決し、会議

を元のタイプ（通常は [Automatic Connect] または 

[One Button To Push]）に戻す必要があります。 

 

拒否またはダウングレードされた会議 

ログの読み取り 

Cisco TMSXE のログは、デフォルトの場所（C:\ProgramData\Cisco\Cisco TMSXE\Logs）にあります。 

TMSXE_decline_downgrade_log_file_YYYYMMDD.txt ログに、拒否またはダウングレードされた各参加者のエントリが作成さ

れます。 

一般的な拒否のシナリオにおけるログ エントリの例を次に示します。 

• 2014-08-19 14:39:50,402 [30] INFO TMSXEBestEffortCommitter - Saving conference as requested was declined 
(conference can never be booked): Unexpected recurrence pattern frequency type encountered: Yearly 

• 2014-08-19 14:39:50,318 [10] INFO TMSXEBestEffortCommitter - Saving conference as requested was declined 
(conference can never be booked): Number of occurrences must be between 1 and 100. 

拒否された会議の再作成 

拒否された会議を解決するには、次の手順を実行します。 

1. ログを使用して、拒否された会議を特定します。 

2. 次のいずれかを実行します。 

• Cisco TMS で主催者の代わりに、サポートされている定期的なパターンを使用して利用可能な時間でこれらの予

約を再作成します。 

• 主催者に連絡し、Outlook を使用して主催者の予約を再作成するように求めます。 

ダウングレードされた会議の修正 

会議をダウングレードすると、Cisco TMSXE はすべての参加者を [Reservation] として予約しようとします。失敗した参加者は

拒否され、すべての参加者が失敗した場合は会議が拒否されます。後者の場合は、拒否された会議に対する手順を参照してくだ

さい。 
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ダウングレードされた会議を修正するには、次の手順を実行します。 

1. ログを使用して、ダウングレードされた会議と失敗した参加者を特定します。 

2. 失敗した参加者の設定またはライセンスの問題を修正します。 

3. Cisco TMS を使用して、修正された参加者を元の予約に再度追加します。 

4. ダウングレードされた各会議の [Type] を [One Button To Push] または [Automatic Connect] に変更します。 

問題のある会議 

Cisco TMS における問題のある会議とは、外部クライアントによって予約され、リソースの競合またはルーティングの問題が発

生した会議です。 

問題のある会議では、予約要求のプロパティはすべて保持されますが、ルーティングが設定されたり、TelePresence リソースが

消費されたりすることはありません。Cisco TMS は、すべての問題が解決されるまで、問題のある会議を開始したり、エンドポ

イントに送信したりしません。 

• ルーティングの問題の場合は、予約に含まれるすべてのエンドポイントが、スケジュールされた時間に [Busy] に設定さ

れます。これにより、管理者またはユーザが問題を解決する間、予約が維持されます。 

• エンドポイントの予約が競合するまれなケースでは、問題のある予約に対してエンドポイントは [Busy] に設定されません。 

問題のある会議は、主催者または管理者が解決できます。 

• 会議が問題のある会議として保存されると、その会議を予約したユーザに電子メールで通知が送られます。ほとんどの問

題は、ユーザが各自のクライアントから要求を変更してスケジュールし直すことによって解決できます。 

• 管理者が問題のある会議を見つけて解決するには、Cisco TMS で [Administrative Tools] > [Diagnostics] > 

[Conference Diagnostics] または [Booking] > [List Conferences] に移動します。 

問題のある会議の原因が、設定エラーまたはルーティング リソースの恒常的な不足にある場合は、管理者が問題を解決す

る必要があります。 

定例会議をスケジュールする際に、特定の回にのみリソースの競合またはルーティングの問題がある場合、Cisco TMS は問題の

ある回のみを問題のある会議として保存します。その他の回は影響を受けません。 

問題のある会議の修正 

問題のある会議として保存された予約を特定して修正を試みる場合は、次の手順を推奨します。 

1. Cisco TMS で、[Administrative Tools] > [Diagnostics] > [Conferences Diagnostics] に移動します。 

2. すべてのエントリを選択します。 

3. [Autocorrect] をクリックします。 

これで、Cisco TMS はすべての問題のある会議および定例会議の再保存を試行し、必要に応じて会議または定例会議を

再ルーティングします。 
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4. [Refresh] をクリックして、各エントリの更新されたステータス フィールドを表示します。[Autocorrect Pending] 状態
のエントリがなくなったら、残りのエントリを 1 つずつ調べて、予約に発生した問題の原因とその解決方法を特定します。 

1. 会議のタイトルをクリックして、会議情報ページを表示します。 

2. 会議情報ページの下部にある [Event Log] タブをクリックします。ログに、ルーティングまたはリソース、ある
いはその両方の問題に関する詳細情報が表示されます。 

3. [Edit] をクリックして、問題の解決に必要な予約のプロパティ（通常は以下）を更新します。 

• ブリッジ リソースの一時的な不足が問題である場合は、会議を移動するか、または会議がリソースを大量
に使用しないようにする（参加者を削除する）必要があります。 

• ブリッジ リソースの恒常的な不足が問題である場合は、環境にリソースを追加しなければ、予約を解決で
きません。 

Cisco TMS の予約インターフェイスでは、変更によってすべての予約の問題が解決される場合にのみ、変更を保
存できます。Cisco TMS 自体から予約するときは、会議を問題のある会議として保存できません。 

Cisco TMS と Cisco TMSXE 間の不一致の特定 

Cisco TMSXE Meeting Analyzer は、Cisco TMSXE とともにサーバにインストールされ、管理者やサポート エンジニアが 

Cisco TMS の予約と Exchange の予約の不一致を特定するのに役立ちます。 
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プロセスの概要 

Meeting Analyzer を実行すると、次の処理が行われます。 

• Cisco TMSXE によって監視されるルームを含むすべての予約（Cisco TMS の会議と Exchange の会議）を取得します。 

• 2 つのソース間で各予約のプロパティを比較し、不一致があればレポートで強調表示します。 

• システムのいずれか 1 つだけに存在する会議を強調表示します。 

次のプロパティが比較されます。 

• 会議が定例会議の一部であるかどうか（定期的なパターンは比較されません） 

• 開始時間（UTC） 

• 終了時間（UTC） 

• Cisco TMSXE に追加されたシステムである参加者 

• [Include meeting titles in consistency check] が有効になっている場合は、Cisco TMS のタイトル/Exchange の件名 

Meeting Analyzer の実行中に複製される会議は、複製が完了するまでエラーとして表示されます。 

ベスト プラクティス 

Meeting Analyzer の実行中は Cisco TMSXE の設定を変更しないでください。Meeting Analyzer はこの設定を起動時にのみロー
ドします。 

Meeting Analyzer を実行すると、特に選択した日付範囲が大きい場合や予約の数が多い場合にサーバに大きな負荷がかかるため、
次のように Meeting Analyzer を実行することを推奨します。 

• 営業時間外に実行する。 
• 営業時間中に緊急のトラブルシューティングが必要な場合は、日付範囲をできる限り小さくして、サーバ パフォーマンス

への影響を軽減する。 

デフォルト設定の変更 

[Configuration] タブを使用して、レポートの保存場所とファイル名パターン、および整合性検査のデフォルトの時間範囲を変更
します。 

レポートのファイル名に変数を使用しなかった場合は、古いレポートが新しいレポートで上書きされることに注意してください。
デフォルトの名前パターンは BookingConsistencyCheckResult-{{timestamp}}.xml です。 

[Include meeting titles in consistency check] を有効にして、Meeting Analyzer で Cisco TMS のタイトルと Exchange の件名
を比較することもできます。 

即時検査の実行 

1. ツールを起動します（[Start] > [All Programs] > [Cisco] > [Cisco TMSXE Meeting Analyzer] にあります）。 
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2. 予約の整合性を検査する日付範囲を指定します。 

日付の選択を使用するか、日付を直接入力します。 

デフォルトの日付範囲は 1 か月です。最大の日付範囲は 2 年です。 

3. [Run] をクリックします。 

データベースのサイズによっては、整合性検査の実行に時間がかかることがあります。検査が完了すると、不一致がある
予約のレポートが表示されます。このレポートは、左側に Cisco TMS のデータ、右側に Exchange のデータを含む表形
式になっています。 

すべての会議は定例会議として表示され、個々の会議レベルでの不一致も定例会議のレベルでフラグ付けされます。 

参加者の不一致がある場合は、一致しない参加者を含むシステムの側に表示されます。 

4. リスト エントリの横のプラス記号をクリックしてドリルダウンし、詳細を確認します。 

一致しないプロパティは赤で強調表示されます。 

5. [Save] をクリックしてレポートを保存してから、ツールを終了します。 

前の整合性検査のレポートにアクセスするには、[Saved Reports] タブに移動します。 

不一致の解決と回避 

Cisco TMS で見つからない会議または正しくない会議の正しい情報が Exchange に含まれている場合は、主催者に会議の招待状

を再送信するように求め、正しい情報を Cisco TMS に複製する必要があります。 

Cisco TMS と Exchange が同期しなくなる根本原因の 1 つは、ユーザがすべての参加者に更新を送信せずに Outlook で予約を

更新またはキャンセルすることにあります。更新を送信することがベスト プラクティスであり、予定表の同期を維持するために

必要であることをユーザに伝えてください。この点については、『Cisco TMSXE User Guide』でも説明されています。 

トランザクション ID を 0 にリセットすると、Cisco TMSXE は Cisco TMS をマスターとしてすべての予約を再複製します。こ

れにより、Cisco TMS の方が正しいと考えられる状況で発生するほとんどの不一致が解決します。 

Cisco TMS から Cisco TMSXE へのレプリケータが異常停止した場合は、大量の不一致が発生するため、サービスを再起動して

ください。失敗した場合は、Cisco のサポート担当者に連絡してください。 

スケジュールされたタスクの設定 

予約の不一致の定期的な分析を実行するには、Meeting Analyzer のコマンドライン インターフェイスを使用して、スケジュール

された Windows タスクを設定することを推奨します。 

この CLI にアクセスするには、BookingConsistencyCheckerCommand.exe を実行します。このコマンドは、完全なファイル 

パスを含んでいないため、このコマンドがある場所から直接実行する必要があります。 

http://www.cisco.com/c/en/us/support/conferencing/telepresence-management-suite-extensions/products-user-guide-list.html�
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表 7 コマンドライン インターフェイスのリファレンス 

スイッチ パラメータ 説明 

help — サポートされているコマンドのリストを出力します。 

noOfDays 整数、最大 730 分析に含める本日からの日数。 

filename .xml 拡張子を含む完全なファイル名ま

たは名前パターン 

次のいずれかを使用してファイルを書き込みます。 

• 指定された名前（分析のたびにレポートが上書きされます） 

• 指定されたパターンを持つ名前 

デフォルトの名前パターンは BookingConsistencyCheckResult-

{{timestamp}}.xml です。 

 

Windows Server 2008 および 2012 でスケジュールされたタスクを設定する手順については、Microsoft の記事「Configure a 

Scheduled Task Item」を参照してください。 

再インストール後のライセンス チェックが失敗する 

アップグレードではなく再インストールを実行すると、Cisco TMSXE に対する Cisco TMS のライセンス チェックが失敗するこ

とがあります。 

これを解決するには、次のいずれかを実行します。 

• Cisco TMS で IIS のリセットを実行します。セットアップが冗長である場合は、両方のノードでこれを実行します。 

• Cisco TMSXE 構成ツールが再起動して Cisco TMS に接続するまで、30 分間待機します。 

タイムゾーンの変更に関する注意事項 

Cisco TMSXE サービスの実行中に Cisco TMSXE サーバのタイムゾーンが変更された場合は、Cisco TMS と Exchange の間で

予約の複製が停止します。 

この状況が発生した場合は、次の手順を実行します。 

1. TMSXE サービスを停止します。 

2. Cisco TMSXE の ProgramData フォルダ（非表示フォルダ。デフォルトの場所は C:\ProgramData\Cisco\TMSXE\）を開

きます。 

3. Storage フォルダの名前を Storage.old に変更します。 

4. TMSXE サービスを再起動します。 

Storage フォルダが Cisco TMSXE によって再作成され、予約の複製が再開されます。 

http://technet.microsoft.com/en-us/library/cc725745.aspx�
http://technet.microsoft.com/en-us/library/cc725745.aspx�
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付録 

付録 1：メールボックスの偽装を使用しない Exchange 2010 の設定 

Cisco TMSXE ユーザによるリソース メールボックスの偽装を許可する [Mailbox Impersonation] の設定を有効にしない場合は、

代わりに次の操作を行う必要があります。 

• サービス ユーザにフル アクセス権限を付与する。 

• Exchange にスロットル ポリシーを適用する。 

それぞれの手順について、次に説明します。 

サービス ユーザへのフル アクセス権限の付与 

これらの権限を付与するには、2 つの方法があります。 

Exchange 管理コンソールを使用する場合： 

1. EMC コンソール ツリーを使用して [Recipient Configuration] > [Mailbox] に移動し、設定するメールボックスを選択し

ます。 

2. ルーム メールボックスを右クリックして [Manage Full Access Permissions...] を選択します。 

3. [Add] をクリックします。 

4. 以前に作成した Cisco TMSXE サービス ユーザを追加して、[Manage] をクリックします。 

5. [Finish] をクリックします。 

Exchange 管理シェルを使用する場合： 

次のコマンドを [mailbox] の部分を設定するメールボックスの名前に置き換えて入力します（@ 記号とドメインは含めません）。 

Add-MailboxPermission -identity [mailbox] -User [service user] -AccessRights FullAccess. 

メールボックスごとに、上記のいずれかの手順を繰り返します。 

Exchange 2010 に対する Cisco TMSXE スロットル ポリシーの適用 

この項は、Exchange 2010 とともに Cisco TMSXE を導入する管理者のみに関連します。 

Microsoft は、Exchange 2010 SP1 のデフォルト設定でクライアント スロットル ポリシー機能を有効にしました。詳細につい

ては、Microsoft の記事「Understanding Client Throttling Policies」を参照してください。 

スロットル ポリシーが設定されていない場合、Microsoft はすべてのユーザにデフォルト ポリシーを適用します。デフォルトの

スロットル ポリシーは、Cisco TMSXE などの企業アプリケーションではなく、ユーザ負荷に対応して調整されています。 

http://technet.microsoft.com/en-us/library/dd297964.aspx�
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Cisco TMSXE のすべての機能が動作するには、Cisco TMSXE アプリケーションのユーザに対してカスタム スロットル ポリシ

ーを適用する必要があります。 

Cisco TMSXE のスロットル ポリシーを適用するには、次の手順を実行します。 

1. Exchange 2010 CAS サーバにログインします。 

2. Exchange 管理シェルを開きます。 

3. カスタム スロットル ポリシーを次のように作成します。 
1. New-ThrottlingPolicy Cisco_TMSXE_ThrottlingPolicy 
2. Set-ThrottlingPolicy -Identity Cisco_TMSXE_ThrottlingPolicy -

EWSFastSearchTimeoutInSeconds 300 -EWSFindCountLimit 6000 -EWSMaxConcurrency $null -
EWSMaxSubscriptions 5000 -EWSPercentTimeInAD 200 -EWSPercentTimeInMailboxRPC 300 -
EWSPercentTimeInCAS 500 

4. このポリシーを Cisco TMSXE ユーザに割り当てます。 
1. $b = Get-ThrottlingPolicy Cisco_TMSXE_ThrottlingPolicy 
2. Set-Mailbox -Identity [service user] -ThrottlingPolicy $b 

Cisco TMSXE のスロットル ポリシーを適用した後でエラーが発生した場合は、Microsoft のスロットル ポリシーに戻せること

に注意してください（「Microsoft スロットル ポリシーの復元」（79 ページ）を参照）。 

スロットル ポリシー パラメータの定義と値 

上記の手順で使用されるデフォルト値は、ほとんどの Cisco TMSXE 導入環境に対応します。導入環境に合わせた調整が必要な

場合は、Set-ThrottlingPolicy の値を調整して、上記のステップ 3b を再度実行します。 

次の表では、Exchange 2010 SP1 の Set-ThrottlingPolicy コマンドのパラメータと値について説明します。 

パラメータ名 説明 Cisco TMSXE 
のデフォルト 

（注） 

EWSFastSearchTimeoutInSeconds Exchange Web Services を使用して行われた検

索がタイムアウトするまでの経過時間を指定しま

す。このポリシーで指定された値よりも検索に時

間がかかった場合は、検索が停止してエラーが返

されます。 

300 各 Cisco TMSXE 

コールのデフォル

トのタイムアウト

は 180 秒です。

各コールは段階的

に停止するため、

300 が付与されて

います。 

EWSFindCountLimit 現在のこのプロセスで当該ユーザに関して、クラ

イアント アクセス サーバ上のメモリに同時に存在

できる FindItem または FindFolder コールの最大

結果サイズ。試行した検索で、このポリシー制限

によって許可される数より多くの項目またはフォ

ルダが見つかった場合は、エラーが返されます。 

6000 このパラメータ

は、特定の時間

におけるすべて

の要求のエント

リの合計の最大

数を制御しま

す。Cisco 
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パラメータ名 説明 Cisco TMSXE 
のデフォルト 

（注） 

ただし、インデックス化されたページ ビューのコ

ンテキスト内でコールが実行された場合、この制

限は厳密に適用されません。具体的には、このシ

ナリオでは、このポリシー制限に収まる数の項目

とフォルダが含まれるように検索結果が切り捨て

られます。その場合は、追加の FindItem または 

FindFolder コールを使用して検索結果へのページ

ングを続行できます。 

TMSXE は、

200 エントリの

みを返すように

要求します。 

EWSMaxConcurrency 1 人の Exchange Web Services ユーザが 

Exchange サーバに対して同時に行える接続の

数。要求を受信した瞬間から要求側に応答全体が

送信されるまで、接続が維持されます。 

ユーザがこのポリシーで許可される数より多くの

同時要求を実行しようとすると、新しい接続の試

行が失敗します。ただし、既存の接続は引き続き

有効です。EWSMaxConcurrency パラメータの有

効な範囲は、0 ～ 100（0 と 100 を含む）です。 

$null EWS の通知の性

質により、同時

要求の数は測定

できません。

$null 値は、この

条件ではスロッ

トルが不要であ

ることを示すた

めに必要です。 

EWSPercentTimeInAD Exchange Web Services のユーザが LDAP 要求

の実行に費やすことができる時間の割合

（PercentTimeInAD）。 

値 100 は、すべての 1 分間について、ユーザが

その時間のうち 60 秒を該当するリソースの消費

に費やすことができることを示します。 

200 この値は 100 よ

り大きくなって

いますが、これ

は特定の時間に

おけるすべての

同時要求に対応

するためです。 

EWSPercentTimeInMailbox RPC Exchange Web Services のユーザがメールボッ

クス RPC 要求の実行に費やすことができる時間

の割合（PercentTimeInMailboxRPC）。 

300 この値は 100 よ

り大きくなって

いますが、これ

は特定の時間に

おけるすべての

同時要求に対応

するためです。 

EWSPercentTimeInCAS Exchange Web Services のユーザがクライアン

ト アクセス サーバ コードの実行に費やすことが

できる時間の割合（PercentTimeInCAS）。 

500 この値は 100 よ

り大きくなって

いますが、これ

は特定の時間に

おけるすべての
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パラメータ名 説明 Cisco TMSXE 
のデフォルト 

（注） 

同時要求に対応

するためです。 

EWSMaxSubscriptions ユーザが特定の Client Access サーバ上で同時に

保持できるアクティブなプッシュ サブスクリプ

ションおよびプル サブスクリプションの最大数。 

ユーザが設定された最大数より多いサブスクリプ

ションを作成しようとすると、サブスクリプショ

ンが失敗し、イベント ビューアにイベントが記録

されます。 

5000 管理されているル

ームの数の 2 倍

に設定します。今

後の拡大に対応で

きる数を割り当

てることを推奨

します。 

 

Microsoft スロットル ポリシーの復元 

Exchange 2010 SP1 に Cisco TMSXE のスロットル ポリシーを適用したときに何らかの理由でエラーが発生した場合は、

Microsoft のデフォルトのスロットル ポリシーに戻すことができます。 

1. Exchange 2010 の CAS サーバにログインします。 

2. Exchange 管理シェル アプリケーションを開きます。 

3. Cisco TMSXE アプリケーション ユーザからスロットル ポリシーの関連付けを削除します（Set-Mailbox -Identity 

[service user] -ThrottlingPolicy $null）。 

4. カスタム ポリシーを削除します（Remove-ThrottlingPolicy Cisco_TMSXE_ThrottlingPolicy）。 

付録 2：Active Directory 接続を使用しない Cisco TMSXE の設定 

Cisco TMSXE が Active Directory ドメインに到達できない導入環境でも、Cisco TMSXE を使用できます。 

この導入シナリオでは、Cisco TMSXE および Cisco TMS で使用可能なユーザに関する情報は非常に限定されることに注意して

ください。 

注意：このモードで Cisco TMSXE の導入を始める前に、Cisco アカウント チームに連絡してください。この運用モードは、

非常に特殊な要件を伴うシナリオに限って推奨されます。運用を開始した後で、データを消失せずに設定を戻すことはできま

せん。 

予約の所有権 

Cisco TMSXE は、主催者の電子メール アドレスを Cisco TMS に渡します。Cisco TMS は、これを既存のユーザの電子メール 

アドレスに解決しようとします。その後、予約の所有権は次のように割り当てられます。 

• 電子メール アドレスが既存のユーザと一致する場合は、そのユーザが予約を所有します。 
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• アドレスと一致する現在のユーザは存在しないものの、AD ルックアップが有効で AD で一致が見つかった場合は、その

ユーザが予約の所有者として Cisco TMS に追加されます。 

• アドレスと一致するユーザが存在せず、AD でもユーザが見つからないかルックアップが有効でない場合は、Cisco 

TMSXE の [Allow organizers without usernames (Non-AD Mode only)] の設定によって動作が異なります。 

• 有効になっている場合、Cisco TMS は電子メール アドレスに基づいて特別なユーザを作成します。このユーザは、

Cisco TMS にログインできませんが、同じアドレスから行われたすべての予約の所有権を保持します。 

• 無効になっている場合、このアドレスから Cisco TMSXE を介して予約されたすべての会議はサービス ユーザに

よって所有され、Cisco TMS の個々の主催者にはリンクされません。 

非 AD モードでのインストール 

Cisco TMSXE を非 Active Directory モードで実行できるようにするには、コマンド ラインで次のように入力して Cisco TMSXE 

インストーラを起動します。 

TMSXESetup.msi NONADCONNECTIONMODE=1 

その後、このドキュメントに記載されている通常のインストール手順に従って、設定の段階まで進みます。 

非 AD モードの設定 

• 構成ツールの [Exchange Web Services] タブで、[Non-Active Directory Mode] を有効にします。 

開いたダイアログで、[Go to Non-AD Mode] をクリックして確認します。 

• [Advanced Settings] タブで、[Allow organizers without Cisco TMS username (Non AD-mode only)] を有効にするか

どうかを決定します。 

• この設定を有効にすると、主催者が Cisco TMS での会議の所有者になります。主催者の電子メール アドレスに対

応するユーザが存在しない場合は、Cisco TMS でユーザが作成されます。 

• この設定を無効にすると、Cisco TMS のサービス ユーザが Cisco TMSXE から行われるすべての予約の所有者に

なります。 

Cisco Collaboration Meeting Rooms Hybrid 

非 AD モードで Cisco Collaboration Meeting Rooms Hybrid が動作するための条件は、次のとおりです。 

• [Allow organizers without usernames] を有効にする必要があります。 

• Exchange での電子メール アドレスに対応するユーザ プロファイルを Cisco TMS で事前に入力する必要があります。 

• Cisco TMS で WebEx シングル サインオンを有効にするか、WebEx のクレデンシャルを使用して個々のユーザ プロ

ファイルを事前に入力する必要があります。 

Productivity Tools は非 AD モードでは動作しません。 
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制限事項 

非 AD モードを使用する場合は、次の制限事項が適用されます。 

• Cisco TMSXE で作成された予約を Cisco TMS から更新できるのは、Cisco TMS の管理者だけです。 

• [Allow organizers without usernames] が有効になっている場合は、Cisco TMS でユーザの電子メール アドレスを変更

しないでください。変更すると、ユーザと予約のつながりが切れます。 

Cisco TMS で AD ルックアップが有効になっていない場合は、すべてのユーザが自分の電子メール アドレスを変更できます。

このため、Cisco TMSXE のエンド ユーザによる Cisco TMS への直接アクセスをすべてブロックすることを強く推奨します。 

• Productivity Tools は非 AD モードと互換性がありません。 

付録 3：3.0.x からアップグレードする場合の再複製のモニタリング 

アップグレード後の最初のサービス起動時に、Cisco TMS にすでに存在するすべての予約の再複製が実行されます。 

大規模なデータベースでは、このプロセスに 3 ～ 5 時間かかることがありますが、このプロセスの進行中もアプリケーションは

稼動しています。 

任意の段階で再複製を監視するには、サービス ログの DEBUG モードをオンにする必要があります。 

ログの場所と使用方法については、「ロギングのしくみ」（64 ページ）を参照してください。 

このプロセスが完了すると、次のステートメントを含む INFO メッセージがサービス ログに追加されます。 

No changes on TMS 

再複製中に更新された定例会議、単一の会議、および回の通知は、INFO メッセージで記録されます。たとえば、Exchange に存

在せず、Cisco TMS から複製された定例会議または単一の会議は、「New item saved」として記録されます。 

Cisco TMS に存在しない TelePresence 会議が Exchange に存在する場合、その会議は削除されます。ほとんどの削除は

「Deleting item of type」の後に削除される会議のタイプが示されて記録されます。ただし、再複製中に同じ会議に対して複数

のトランザクションが実行された場合、これは別の方法で記録されます。 

会議 ID を見つけるには、該当するログ メッセージから上に向かって最も近くにある「Cleaning up conference」というメッセ

ージを見つけます。 

再複製は、まだ開催されていない会議にのみ影響することに注意してください。「Not updating」というメッセージが見つかっ

た場合、それは過去に発生した不一致が検出されたことを意味するため、修正されません。 

中断されたアップグレードの再開 

インストールが完了し、設定ウィザードが起動される前にプロセスが中断した場合は、トランザクション ID のリセットが行われ

ていない可能性があり、Cisco TMSXE サービスを起動しても再複製が開始されません。 
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トランザクション ID がリセットされたかどうかを確認するには、設定ログに次のステートメントを含む INFO メッセージがある

かどうかを調べます。 

Finished resetting transaction id on all systems 

ログの場所と使用方法については、ロギングのしくみ」（64 ページ）を参照してください。 

影響を受ける各システムの Cisco TMS システム ID を含む別個のステートメントも見つかります。 

これらのステートメントが見つからなかった場合は、次の手順を実行します。 

1. コマンド プロンプトを開きます。 

構成ツールは、デフォルトでは C:\Program Files\Cisco\TMSXE\ConfigurationApp.exe にあります。 

2. -wizard -resetAllTransactionIds スイッチを使用して構成ツールを実行します。 

構成ツールが起動します。 

3. 「付録 3：3.0.x からアップグレードする場合の再複製のモニタリング」を参照してください。 

-resetAllTransactionsIds スイッチ  

-resetAllTransactionIds スイッチを指定すると、Cisco TMS と Exchange 間の不一致の一括クリーンアップが開始されます。 

注意：再複製プロセスは、完了までに時間がかかることがあり、プロセスが完了するまで予定表の同期が失われるため、営業

時間外に実行する必要があります。 

既存の会議の試験インポートの実行 

予定されているスケジュール済み会議をすでに含んでいるリソース メールボックスを再使用するときは、Cisco TMSXE の試験

インポート機能を使用して、Cisco TMS で予約可能な会議を確認できます。 

試験インポートの実行前に Cisco TMSXE にすべてのシステムがそろっていない場合もあるので、実行後に Cisco TMS と Cisco 

TMSXE の両方をリセットする必要があります。 

1. 標準の SQL ツールを使用して Cisco TMS データベースのスナップショットを作成します。 

2. コマンド ライン パラメータ TRIALIMPORT=1 を指定して Cisco TMSXE インストーラを実行します。 

3. 構成ツールが起動したら、Cisco TMS と Exchange の接続を設定します。 

4. [Systems] タブで、Cisco TMS 内の対応するシステムにマップされたメールボックス アドレスの編集済み .csv ファイル

を追加します。 

5. 設定を完了し、プロンプトが表示されたら Cisco TMSXE サービスを起動します。 

• 試験インポートが完了すると、サービスが自動的に停止します。 

• 拒否およびダウングレードのログを調べて、インポートできない会議とその理由を確認します。 
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• Cisco TMS の [Booking] > [List Conferences] または [Administrative Tools] > [Diagnostics] > [Conference 

Diagnostics] を使用して、Cisco TMS で [Defective] として保存された予約を特定できます。 

試験インポートの後で製品を機能状態にするには、次の手順を実行します。 

1. Cisco TMS データベースのスナップショットを復元します。 

2. Cisco TMSXE をリセットします。 

1. Cisco TMSXE のプログラム フォルダから ConfigurationApp.exe -EndTrialImportMode コマンドを実行

して、構成ツール自体を開かずに試験インポート モードを無効にします。 

2. [Services] パネルで、Cisco TMSXE Windows サービスを無効にします。 

最終的なインポートを実行できる状態になるまで、サービスを無効のままにする必要があります。 

3. 試験インポート中に追加したシステムは、Cisco TMSXE の設定フォルダ内の MonitoredSystems.xml ファイルに

保存されています。 

• もう一度同じエンドポイントから同じメールボックスにマップされる会議をインポートする場合は、この

ファイルを保持しておきます。 

• 別のエンドポイント/メールボックス設定を使用してインポートできるようにするには、このファイルを削

除します。 

注意事項 

マニュアルの入手方法およびテクニカル サポート 

資料の入手方法、Cisco Bug Search Tool（BST）の使用方法、サービス要求の送信および追加情報の収集方法については、

『What's New in Cisco Product Documentation（Cisco 製品資料の更新情報）』

（http://www.cisco.com/c/en/us/td/docs/general/whatsnew/whatsnew.html）を参照してください。 

『What's New in Cisco Product Documentation』は、シスコの新規および改訂版の技術マニュアルの一覧も示し、RSS フィー

ドとして購読できます。また、リーダー アプリケーションを使用してコンテンツをデスクトップに配信することもできます。

RSS フィードは無料のサービスです。 

アクセシビリティ通知 

シスコは、利用しやすい製品およびテクノロジーの設計および提供に取り組んでいます。 

シスコのアクセシビリティの詳細については、次を参照してください。 

www.cisco.com/web/about/responsibility/accessibility/index.html 

http://www.cisco.com/c/en/us/td/docs/general/whatsnew/whatsnew.html�
http://www.cisco.com/web/about/responsibility/accessibility/index.html�
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マニュアルの変更履歴 

日付 説明 

2015 年 8 月 テクニカル プレビューに Office 365 のサポートが含まれなくなったことを反映して更新しました。 

2014 年 10 月 Cisco TMSXE 4.1 のリリース。ダウングレードされた会議、問題のある会議、および拒否された会議の処理

に関するトラブルシューティングの項が新たに含まれています。 

2014 年 7 月 Cisco TMSXE 4.0.3 のリリース。更新手順の変更が含まれています。 

2014 年 5 月 Cisco TMSXE 4.0.1 のリリース。アップグレード手順を更新し、クラスタリングに関する情報を追加しま

した。 

2014 年 5 月 Cisco TMSXE 4.0 のリリース。Cisco TMSXE の独立したインストール ガイドとアドミニストレータ ガイド

に代わって作成された、この導入ガイドの初版。 

 

シスコの法的情報 

このマニュアルに記載されている仕様および製品に関する情報は、予告なしに変更されることがあります。このマニュアルに記

載されている表現、情報、および推奨事項は、すべて正確であると考えていますが、明示的であれ黙示的であれ、一切の保証の

責任を負わないものとします。このマニュアルに記載されている製品の使用は、すべてユーザ側の責任になります。 

対象製品のソフトウェア ライセンスおよび限定保証は、製品に添付された『Information Packet』に記載されています。添付さ

れていない場合には、代理店にご連絡ください。 

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, 
Berkeley (UCB) as part of UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, 
Regents of the University of California. 

ここに記載されている他のいかなる保証にもよらず、各社のすべてのマニュアルおよびソフトウェアは、障害も含めて「現状の

まま」として提供されます。シスコおよびこれら各社は、商品性の保証、特定目的への準拠の保証、および権利を侵害しないこ

とに関する保証、あるいは取引過程、使用、取引慣行によって発生する保証をはじめとする、明示されたまたは黙示された一切

の保証の責任を負わないものとします。 

いかなる場合においても、シスコおよびその供給者は、このマニュアルの使用または使用できないことによって発生する利益の

損失やデータの損傷をはじめとする、間接的、派生的、偶発的、あるいは特殊な損害について、あらゆる可能性がシスコまたは

その供給者に知らされていても、それらに対する責任を一切負わないものとします。 

このマニュアルで使用している IP アドレスおよび電話番号は、実際のアドレスおよび電話番号を示すものではありません。マニュ

アル内の例、コマンド出力、ネットワーク トポロジ図、およびその他の図は、説明のみを目的として使用されています。説明の

中に実際のアドレスおよび電話番号が使用されていたとしても、それは意図的なものではなく、偶然の一致によるものです。 

ハード コピーおよびソフト コピーの複製は公式版とみなされません。最新版はオンライン版を参照してください。 
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シスコは世界各国 200 箇所にオフィスを開設しています。Addresses, phone numbers, and fax numbers are listed on the 
Cisco website at www.cisco.com/go/offices. 
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